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What's New in SignAgent Pro 4.0 

Welcome to SignAgent Pro 4.0! 

This new version of SignAgent Pro completely overhauls the registration system, meaning an end 
to the slow start-up and restrictive FileMaker Pro versions of SignAgent Pro 3.0. 

You can see more details on that here: Managing Registrations 

The main benefit to this is that you can now use SignAgent Pro with newer versions of FileMaker 
Pro, including 15, 16, and 17. 

This version also has a number of bug fixes, including script performance improvements and a fix 
to a bug which caused SignAgent Pro to crash when choosing reports. 

Unfortunately, this update is currently not compatible with InDesign CC 2019. See this article for 
more details: Adobe InDesign compatibility 
We'll be looking to adding this compatibility as soon as we can and will issue a small update to the 
scripts at that time. 

One other thing to note is that this will likely be the LAST MAJOR UPDATE to SignAgent Pro. 

With the new, web-based SignAgent, we can include way more features and go way further than 
we ever could with SignAgent Pro, and we’re going to be focusing our energy into making sure 
that’s the best product it can be. If you haven’t seen a demo yet, or if you’d like more information, 
you can schedule a meeting time here: https://signagent.as.me/demo 
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Managing Registrations 

Registering your SignAgent Pro files 
Registering your SignAgent Pro files is easy! When you first go to Sync a project file on a computer, 
you'll be prompted for a registration string. 

Just enter your SignAgent Pro registration string (same one that you received for earlier versions of 
SignAgent Pro), and you should be good to go. 

Unregistering a Computer or Managing SignAgent Pro 
Registrations 

Managing your SignAgent Pro registrations is easy as well! Simply click the "Manage Registrations" 
button in the SETTINGS table, and that will take you to the appropriate page in SignAgent Online. 
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Alternatively, you can just log in to your account or trial account in SignAgent Online and choose 
Licenses 

 If you don't have an account for SignAgent (online), it's easy to sign up! Just sign up here: 
https://app.signagent.com/accounts/signup/ 

This will also start you into a 30-day free trial for the new version. If you're not ready for 
that just let us know. 

Once you've done that, just let us know and we'll help you to link your existing SignAgent 
Pro licenses into your new SignAgent Online account. 
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Once you've made it to the Licenses page, select "Legacy" 

Here you can see information about your SignAgent Pro account, including registration string, total 
number of licenses used, and which computers currently have an active license. 

To adjust a computer's active license, select it by clicking on its name. 

From here, you can adjust a computer's nickname (to make it more clear for you in the future), or 
you can Unlink this computer from your license. 
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Review Script Basics 
SignAgent Review™ is a script to be used by project managers, clients, and in-house decision 
makers to review sign location plans created in SignAgent Pro. 

1. The client needs to have InDesign and install the sync script. For information on how to do that, 
check out this tutorial here: Installing Scripts 

2. To start reviewing, double click the Review Script. They can then review the message and sign 
information while simultaneously seeing it's highlighted location on the plan, with the option to 
approve the sign or to reject the sign (with reason). 

3. Once reviewed the sign is automatically moved to the Approved or Rejected layer and hidden, 
with a dialog showing progress as they go through. 

4. Once completed, they will return the file to the designer, who will perform a sync, bringing any 
comments into the notes field with time, date and reviewer noted. 
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Set Up 
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SignAgent Pro Setup Video 
Note: We've launched a new cloud-based SignAgent. It includes automatic vector artwork creation, 
invites everyone to collaborate, and organizes everything in one place. 

This is an overview video for the new SignAgent. 
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Installing FileMaker Pro 

FileMaker Pro 

FileMaker Pro is the first software requirement for using SignAgent Pro™. The most recent version 
that is compatible is FileMaker Pro Advanced 17 
Development is no longer ongoing for SignAgent Pro, so future versions of FileMaker Pro may or 
may not work. 

For more information on which versions are compatible, check out this tutorial here: FileMaker Pro 
Compatibility 

You can learn more here: FileMaker Pro Advanced 

If you need a trial version to get started, you can find that here: FileMaker Pro 17 Trial 
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Install Scripts 
The latest scripts can be found on our shared Dropbox here: Scripts for SignAgent Pro 4 

Step-by-Step 

1. Open New Scripts or Scripts folder in SignAgent Pro folder (on Dropbox). You can find the most 
current scripts here: Scripts for SAP 4 

2. Copy Script files (Edit.jsx, Sync.jsx, Preferences.jsx, Review.jsx, Installer) 
3. Go to Applications folder 
4. Open Adobe InDesign folder (whatever your current version is) 
5. Open Scripts folder 
6. Open Scripts Panel folder 
7. Paste files (command + v) 
8. Within the Scripts folder, un-zip the ExtendExtendScript.1.0.3.zip file, and from there run the 

Installer.app (Mac) or Installer.exe (PC). Once this is done, you'll have to restart InDesign in 
order for the scripts to run properly. 

The new Installer allows InDesign to access our secured authentication server. Note, that since this 
Installer was not downloaded from the App Store, you may need to adjust your security settings 
for it to run properly. 

IMPORTANT: Set your preferences how you'd like before using any of the other scripts. For more 
information about the preferences script, check out this tutorial here: 

Preferences Script Overview 

For more information on using scripts, check out these tutorials here: 

Using Scripts 
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Download Options 

1. Download 

This will take you to our shared Dropbox Folder. 

2. Two Options 

1. If you click 'Direct Download'. You will find the Folder on your computer in your downloads 
which contains all the necessary files. 

2. You can also choose to save in your own personal Dropbox. 
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NOTE: 

• The SignAgent Pro™ folder structure must be kept intact in order to work properly, check out 
this tutorial for more info on Folder Structure: https://signagent.zendesk.com/entries/
80957199-Folder-Structure 

• Our Dropbox Folder is meant for sharing files back and forth. Please do not use this folder to 
work on your projects, and clear the folder out when you have finished downloading. 
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Installing Adobe InDesign 

Adobe InDesign 

Adobe InDesign is the second software requirement to use SignAgent Pro™. 

Versions of Adobe InDesign CC will work, up to and including CC 2018. For more info on which 
versions are compatible, check out this article here: Adobe InDesign Compatibility 

You can learn more here: Adobe InDesign 

If you need a trial version to get started, you can find that here: InDesign Trial 

Note that InDesign 2019 is not currently compatible, as we're waiting on an update that will allow 
InDesign 2019 to connect to our authentication server. 

InDesign 2018 is available for an easy and free downgrade for anyone who has an active Creative 
Cloud subscription. You can see details on that here: Install Previous Version of CC Application 
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Keyboard Shortcuts 

Video 

Watch this video to setup the keyboard shortcut for scripts. 

NOTE: This video was made with files from an older version of SignAgent Pro™. Instead of Adobe 
InDesign CS5, find the version of InDesign that you currently use... The dialog box will look slightly 
different, but the process is the same. 

Step-by-Step 

1. Open InDesign 
2. Select Edit menu: Keyboard Shortcuts... 
3. Under Product Area Select: Scripts 
4. Under Commands Select Script. 
5. Input keyboard shortcut 
6. Assign shortcut 
7. Save shortcut group as SignAgent Pro 

Edit.jsx 
Mac: command + shift + 1 

Latest Sync Script 
Sync: command + shift + 2 
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Folder Structure 
This tutorial will outline the current folder structure for SignAgent Pro 

General Folder Structure 

Each SignAgent Pro™3.0 folder should contain the following: 
• An Archive folder 
• An Excel folder 
• A Links folder 
• A Reports folder 
• A SignAgent Pro-3.fmp12 file (FileMaker database) 
• A SignAgent Pro-3.indd file (InDesign document) 
• An XML folder 

It's extremely important that you DO NOT CHANGE the names of any of these files/folders!!! If you 
change them you could cause any number of unpleasant errors. 
The only exceptions are: 

• The InDesign document... you can rename that to whatever you like. 
• The SignAgent Pro-3_0 folder can be named whatever you like as well. The only thing to note is 
that you should avoid using certain special characters, especially "&,*,%,#,!,+,=,and .," 

Archive Folder 
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The Archive folder includes a copy of 
1. The InDesign file from just before the last time you synchronized... It will be replaced every time 
you synchronize 
2. The FileMaker database from just before the last time you synchronized... it will be placed every 
time you synchronize 

This means that the files in the Archive folder will always contain the same data and will be 
correctly linked. 
To recover these files and start back from before the last time you synchronized, just move them 
from the Archive folder into the main SignAgent Pro™ folder, replacing the FileMaker database and 
the InDesign document currently in the main SignAgent Pro folder. 

Excel Folder 

The Excel folder is where any exported Excel files will be automatically saved to after being 
exported from SignAgent Pro 

Links Folder 

In the LINKS folder, you may find the following subfolders (DON'T CHANGE THE FOLDER NAMES) 
Plans - Place your floor plans for InDesign here 
SIGN - SignAgent Pro will automatically place links to all the pictures in the SIGN table in this 
folder... also don't change the subfolder names here 
TYPE - SignAgent Pro will automatically place links to all the pictures in the TYPE table in this 
folder... also don't change the subfolder names here. 
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Reports 

This folder contains separate databases for the customizable reports... don't touch these or worry 
about them too much. 

The Reports.fmp12 file contains all the templates for all the customized reports you've created, 
including the default reports 
The Bridge.fmp12 file passes the information back and forth between the main SignAgent 
Pro-3.fmp12 file and the Reports.fmp12 file, like a bridge, if you will. 

XML 

This folder contains background information that is passed between FileMaker and InDesign. 
Don't touch it. Don't worry about it. 
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Getting Started 
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SignAgent Overview Video 
Note: We have a new cloud-based SignAgent software. For more information visit our website 
here: 

https://signagent.com/ 

This video will show you an overview of the new cloud-based SignAgent. 
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Starting a New Project 
When starting a new project it is recommend that you start by using the latest version of SignAgent 
Pro™. 

Related Tutorials: 
What is the latest version? 
What Version Do I Have? 

Copy Existing Template Folder 

When you do this, make sure you copy the entire SignAgent Pro™ project folder. Note that the 
default name for this folder should be SignAgentPro-3_0_1-ISSUED 

There are 3 possible options: 

1. Dropbox - Check Dropbox for the latest version of SignAgent Pro™ and copy it to your 
computer. Make sure you copy the folder and not just move it to your computer. 

2. From Internal Server - Copy the latest version of SignAgent Pro™ master folder to local 
computer from the server. Check with your IT department for the exact location of the template 
files. 

3. From Existing Project - Copy existing project and remove all but one sign in the location plan. 
Make sure the folder you are copying are the latest version of SignAgent Pro™. 

Once you've done this, you can open up your FileMaker file and InDesign file and start setting up 
your new project! 
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Opening SignAgent Pro 
Follow the steps below to open your files. I recommend not to use the "Open Recent" command in 
InDesign or FileMaker. These often link to older versions of the files and can create 
synchronization confusion. 

Find Files 

The SignAgent Pro™ folder and files are either stored: 

1. Locally on your computer 
2. On your company's network. 
3. Remotely, on a server or other remote drive. 

Do NOT use the files directly from the dropbox... make a copy of them first. 

Open Files 

Open the following files: 

1. FileMaker Pro File 
2. InDesign Document 
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InDesign File Not Opening? 

You need to open the .idml file instead of the .indd file. 

Read this tutorial: 
Why is there an .IDML file 
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How to Add Floor Plans to SignAgent Pro™ 
This tutorial will give you step-by-step instructions on how to add floor plans to the your SignAgent 
Pro™ InDesign document. 

1. Prepare your Floor Plans 

The first step is to find your floor plans and make sure they're ready to go. We typically 
recommend using a PICT file (.pct), for its small size and high resolution, but other image or file 
types can work as well. For info on PICT files, check out this tutorial here: Preparing PICT Location 
Plans 

We also recommend that you keep place any floor plans you'll be using in the Links folder of your 
new SignAgent Pro™ project folder, so they're easy to find, and you'll always have access to them, 
even if you move your SignAgent Pro™ folder from computer to computer. 
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2. Add Floor Plans to InDesign 

Once you've opened your InDesign document, follow these steps. 

1. Open up the Layers Panel (Go to Window > Layers, or press F7), or just choose it, if it's already 
open. 
2. Select the Plans Layer (by clicking on it) and unlock it (by clicking on the little lock icon). If there 
are already floor plans in here, delete them (if unwanted) by clicking on the floor plan and pressing 
delete. 
3. Place your new floor plans by going to File > Place... (or pressing command + D on Mac or ctrl + 
D on PC), finding your floor plan from Step 1, and clicking where you want the top-left corner of 
these plans to be. 
4. Lock the Plans layer by clicking in the little grey square in the layers panel (see above image for 
clarification) 

If your project only has one floor, then you can skip to step 4! Otherwise... 
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Step 3. Another Page! 

If you've got a project with multiple floors, you'll probably want to place each floor on its own 
separate page. Here's how to do that: 
1. Go to the Pages Panel (Go to Window > Pages or press command + F12 on Mac or ctrl + F12 on 
PC) or just choose it, if it's already open. 
2. Add a blank page by either clicking the New Page button, or right-clicking (ctrl-clicking on Mac) 
and selecting Insert Pages... Note that if you choose the Insert Pages option, you can add multiple 
pages at a time, which can be convenient for larger projects. 
3. Go to your new, blank page, either by double-clicking it in the Pages Panel, or using the page 
navigation tools at the bottom-left of your window. 
4. Repeat Step 2: Add Floor Plans to InDesign. 

Once you've added all the necessary plans to InDesign, there's one last step... 
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4. Add Levels to the LEVEL Table in FileMaker Pro 

Alright, last step! If you haven't already, open up your SignAgent Pro-3.fmp12 database file, and do 
the following: 
1. Go to the LEVEL Table 
2. Create level entries in here, either by using the New or Duplicate buttons. 
3. Re-order your entries, if necessary, by using the Up and Down buttons... keep in mind that the 
order they are sorted here will affect the order they are sorted in other places across SignAgent 
Pro™, including your reports. 

And you're done! It's a bit of work to set up, but once this is done, you'll be ready to speed through 
some seriously well documented sign programming! 
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Creating a Sign (InDesign) 
This tutorial will teach you how to create a sign in SignAgent Pro™ from InDesign. 

Every new project of SignAgent Pro™ starts off with 1 sign (in both InDesign and FileMaker Pro) 
In this tutorial, we'll be creating a new sign in Adobe InDesign 

1. Copy and Paste (InDesign) 

You can simply copy the original sign in InDesign and paste a new one. 
1. Select the original sign 
2. Copy by pressing Command + C (or ctrl + C on PC) 
3. Paste by pressing command + V (or ctrl + V on PC). The new sign will show up in the middle of 
your screen. 
4. Drag the sign into its proper location. 
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2. Option (Alt) + Drag (InDesign) 

You can also use the option-drag method. 
1. Select the original sign 
2. Hold down option (or alt on PC) 
3. Click on the original sign, and drag the new sign to its proper location. 

NOTE: Any signs you create in InDesign will not show up in FileMaker Pro until you synchronize. 
See tutorial here: Synchronization 
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Setting up your TYPE Table 
This tutorial will teach you how to set up your list of sign types in your TYPE table. It is 
recommended that you do this before beginning your sign programming. 

1. Go to the TYPE Table 

The TYPE Table keps track of all the different sign types in your project. It also affects the drop-
down lists that show up in your SIGN table, and in InDesign. 
As a general rule, it's easiest to add sign types before doing the bulk of your programming. Note 
that there are a number of sign types already in a default database. 

You can get to this screen by clicking on TYPE. 

2. Delete Types That You Don't Need 

Once you're in the TYPE table, it's time to start customizing the list. First, let's delete any sign types 
we're not going to use. In this example, we're going to get rid of S1 (Level ID), U1 (Unique Sign 1), 
and X1 (Other Sign we use.) 
This will remove it from your type list, and from any Type drop-downs in the SIGN table or in 
InDesign. 
NOTE that deleting a type from this table will not delete any signs, even if they do currently have 
that sign type. 

To do this... 
1. Select the Sign Type you'd like to delete (by clicking on it's record) 
2. Click Delete. (You'll get a warning message, so make sure you're deleting the right stuff.) 
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3. Add the Sign Types That You Do Need 

The next logical step is to add the sign types that you are going to use in this project. For this 
example, I'm just going to add A3 (Small Department ID) 
Don't forget to add other information, like Drawing Number, Background Colour, Text Colour, Unit 
Cost, etc. if you want it to show up in your Sign Count/Sign Estimate Reports 

1. Click New (the new type will show up directly below the currently selected type) 
Alternatively, you can also use the Duplicate button, instead of New. This will duplicate the 
currently selected type. 
2. Enter the necessary information 
3. Move the type to the proper location in the list using the Up and Down buttons 

Remember that the TYPE Table is MANUALLY sorted, so just place your new sign type where you 
would like to be sorted. 

Also Remember that the Background Colour/Text Colour will affect how those sign types are 
displayed in your reports. 
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Interface Overview 
This tutorial is a brief overview of the different layouts used in SignAgent Pro™. 

1. Dark grey box indicates that this is the active layout 
2. Project Title (Editable in SETTINGS) 
3. No colour indicates that this is an inactive layout 
4. Active layout's toolbar 
5. Field headers 
6. Records 
7. Version number 
8. Thin dark rectangle indicates that this is the active record 
9. Sort Order. How the records are currently sorted. 

10. Licensed To - Shows who SignAgent Pro™ is licensed to. 
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FM 12 Registration Server Status 
The registration system is ONLINE at the moment. You should have no problem getting in 
to SignAgent Pro™ or SignAgent Manager™! 
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Creating a Sign (FileMaker) 
This tutorial will teach you how to create a sign in SignAgent Pro™ from FileMaker Pro 

Every new project of SignAgent Pro™ starts off with 1 sign (in both InDesign and FileMaker Pro) 
In this tutorial, we'll be creating a new sign in FileMaker Pro 

There are 2 ways to create a new sign in FileMaker 

1. New 

1. Go to the SIGN table 
2. Click New 

Note that this will create a BLANK record. It is recommended that you now fill out the information 
for this sign. (especially the fields that are highlighted in RED) 

2. Duplicate 

1. Go to the SIGN table 
2. Select the sign you want to duplicate by clicking on it. (You can see which sign is currently 
selected by the black bar on the left-hand side of the screen) 
3. Click Duplicate 
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Note that this will create a DUPLICATED record. It is recommended that you now modify any 
necessary information for this sign (especially the fields that are highlighted in YELLOW) 

3. Synchronize 

Once you've added all the signs you need, switch to InDesign and Synchronize by presseing 
cmd+shift+2 on Mac or ctrl+shift+2 on PC. 
Then, switch back to FileMaker and click SYNC. 

4. Sync Complete, but.... 

When receiving new signs from FileMaker, InDesign will place them all in a row in the top-left 
corner of the active page and on a new Layer called Import: datestamp. 
These signs are all in 1"x1" boxes. 

All you have to do now is format them properly and move them all to the right location! 
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5. Mass re-formatting trick 

Note: I applied the a standard Object Style that I had used for other signs in the project, just so I 
could accurately re-size the signs based on that font. 

1. Re-size one sign to the proper dimensions (refer to another sign in the project for exact 
measurements) 
2. Select the rest of the imported signs 
3. Go to Object > Transform Again > Transform Sequence Again Individually 

Success! 

Now all you have to do is move them to their proper locations and apply the appropriate object 
styles, if necessary. 

Note: You can feel free to move these signs off of the new Import Layer onto whichever layer you 
like! 

Page 41SignAgent Pro 4.0



Closing SignAgent Pro™ 

Introduction 

Follow the steps below to close your files. 

Step 1 - Perform Synchronization 

Synchronize SignAgent Pro prior to closing the files. That way when you return to work on the files 
the will be the same. 

Synchronization 

Step 2 - Close Database 

1. Select: File 
2. Select: Close (Cmd + W) 
3. or Press: Red (x) Button 
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Note that FileMaker is constantly saving your work, so you don't have to worry about pressing 
save. 

Step 3 - Save Location Plan 

1. Select: File 
2. Select: Save (Cmd + S) 

Step 4 - Close Location Plan 

1. Select: File 
2. Select: Close (Cmd + W) 
3. or Press: Red (x) Button 

Page 43SignAgent Pro 4.0



Complete! 

You have closed your SignAgent Pro files. 
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Deleting Signs 
This tutorial will teach you how to delete signs in 3 ways, depending on your needs for the project. 

Deleting signs... an unpleasant necessity, when the fruits of our labour must be struck from the 
record. But how we delete signs in SignAgent Pro™ will depend on what our documentation needs 
are... there are 3 ways to "delete" a sign in SignAgent Pro™: 

1. Hide the sign from all reports, but keep it in the database and location plans 
2. Mark the sign as deleted, but still show it on reports and keep it in the database and location 
plans 
3. Completely and permanently delete the sign from existence. 

METHOD 1: Hide the Sign 

This method will completely hide the sign from all reports, and grey it out in the SIGN table. 
It will still remain in the database and the location plan. 

1. Go to the SIGN Table 
2. Select the sign you wish to hide, and set the Status to Hide 
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Note that it will grey the sign out in the sign table, and completely hide it from reports. 
This also means that any signs that are marked "Hide" will not contribute to sign counts or 
estimates. 

METHOD 2: Mark Sign as Deleted 

This method will mark the sign as deleted in the SIGN table and in all reports, as well as set its 
quantity to zero. 
It will still remain in the database and the location plan. 

1. Go to the SIGN Table 
2. Select the sign you wish to mark as deleted, and set the Status to Deleted 
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Note that it will strike the sign out in the SIGN table and in all reports. 

INDESIGN NOTE 

NOTE: Marking the status as "Hide" or "Deleted" will NOT affect the sign's appearance in InDesign. 
You may choose to 

a) Hide the sign by placing it on a layer and turning that layer's visibility off. 
b) Strike the Sign ID out by assigning it a character style or object style with a strikethrough. 

DO NOT just delete the sign in InDesign if you want to keep a record of it in the database. 

METHOD 3: Completely Delete 
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This method will completely wipe the sign from existence, strike it from the record, exterminate, 
what have you. It will be gone forever. 
It will no longer be in the database or the location plan. 

1. Select the sign to be deleted in InDesign 
2. Press Delete 
3. Synchronize 

Voila! This sign is now gone forever, and can not be recovered. If you need it back, you will have to 
create it again. 
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SIGN 
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SIGN Replacing Options 
This tutorial provides an overview of the SIGN field content replacement options in SignAgent 
Pro™. 

NOTE: While replacing information in many records at once may save you time, you can also 
inadvertantly overwrite a lot of data and THERE IS NO UNDO. BE CAREFUL. 

1. Type - Replace - Press button to replace all the Type fields in the current found set with the 
current field contents. There is a dialog that explains this process before committing the 
change. 

2. Level - Replace - Press button to replace all the Level fields in the current found set with the 
current field contents. There is a dialog that explains this process before committing the 
change. 

3. Number - Serial Replace - Press button to serial replace all the Number fields in the current 
found set. There is a dialog that explains this process before committing the change. 

4. Message - Replace - Press button to replace all the Message fields in the current found set 
with the current field contents. There is a dialog that explains this process before committing 
the change. 

5. Notes - Replace - Press button to replace all the Notes fields in the current found set with the 
current field contents. There is a dialog that explains this process before committing the 
change. 

6. Clients Notes - Replace - Press button to replace all the Clients Notes fields in the current 
found set with the current field contents. There is a dialog that explains this process before 
committing the change. 

7. Internal Notes - Replace - Press button to replace all the Interal Notes fields in the current 
found set with the current field contents. There is a dialog that explains this process before 
committing the change. 

8. Quantity - Replace - Press button to replace all the Quantity fields in the current found set 
with the current field contents. There is a dialog that explains this process before committing 
the change. 

9. Phase - Replace - Press button to replace all the Phase fields in the current found set with the 
current field contents. There is a dialog that explains this process before committing the 
change. 

Page 50SignAgent Pro 4.0



10. Status - Replace - Press button to replace all the Status fields in the current found set with the 
current field contents. There is a dialog that explains this process before committing the 
change. 
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SIGN Sorting Options 
This tutorial provides an overview of the SIGN sorting options in SignAgent Pro™. 

1. Type - Press the header to toggle through different sort options (Unsorted, Detailed | Type 
and Type). 

2. Level - Press the header to toggle through different sort options (Unsorted, Detailed | Level, 
Number and Level, Number). 

3. Number - Press the header to toggle through different sort options (Unsorted, Detailed | 
Number, Level and Number, Level). 

4. Message - Press the header to toggle through different sort options (Unsorted, Detailed | 
Message, Type and Message, Type). 

5. Message Translated - Press the header to toggle through different sort options (Unsorted, 
Detailed | Translated Message and Translated Message) 

6. Notes - Press the header to toggle through different sort options (Unsorted, Detailed | Notes 
and Notes). 

7. Clients Notes - Press the header to toggle through different sort options (Unsorted, Detailed 
| Clients Notes and Clients Notes). 

8. Internal Notes - Press the header to toggle through different sort options (Unsorted, Detailed 
| Internal Notes and Internal Notes). 

9. Art - No Sorting 
10. Pictures - No Sorting 
11. Quantity - Press the header to toggle through different sort options (Unsorted, Detailed | 

Quantity and Quantity). 
12. Phase - Press the header to toggle through different sort options (Unsorted, Detailed | Phase 

and Phase). 
13. Status - Press the header to toggle through different sort options (Unsorted, Detailed | 

Status and Status). 
14. Creation Information - Press the header to toggle through different sort options (Unsorted, 

Detailed | Creation Timestamp and Creation Timestamp). 
15. Modification Information - Press the header to toggle through different sort options 

(Unsorted, Detailed | Modification Timestamp and Modification Timestamp). 
16. Here you can see the current sort order 
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SIGN Toolbar 
This tutorial provides an overview of the SIGN Toolbar used in SignAgent Pro™. 

1. SIGN - Press the SIGN button a second time to show either the "Secret" layout or the expanded 
SIGN layout. 

2. New - Use to create a new sign. When synchronized with InDesign this sign will appear in a new 
layer in the top right corner of the active page. 

3. Duplicate - Use to duplicate an existing sign. When synchronized with InDesign this sign will 
appear in a new layer in the top right corner of the active page. 

4. Delete - It is not possible to delete in FileMaker Pro. Use To Button (11) to find the sign in 
InDesign and delete in InDesign. 

5. Find - Use to find sets of information. For example: Press Find Button and then input Phase 2 
into the Phase field to find all Phase 2 signs. 

6. Re-Find - Use if you didn't quite find what you wanted to with your last Find request. 
7. Find Missing - Use to find fields marked as Red or Missing. This searchs for missing 

information in the Sign ID fields, Phase and Status fields. 
8. Find Duplicate - Use to find fields marked as Yellow or Duplicated. This searchs for 

duplicated information in the Sign ID field combinations. 
9. Show All - Use this button to show all records. 

10. Omit Hidden - Use this button to hide all the records that are marked as Hidden. Records can 
be marked as Hidden one of three ways. Either the sign's Level, Phase or Status is marked as 
being hidden in there related tables. 

11. To - Use this button to automatically copy the Sign ID into the computer's clipboard. The Sign 
ID can then be paste into the find dialog in InDesign to pinpoint the exact location. 

12. From - Use this button after you've copied the Sign ID from InDesign into the computer's 
clipboard. Pressing this button will automatically perform a find based on the contents of the 
computer's clipboard. 

13. SUPPORT - Pressing SUPPORT will take you to the SignAgent Pro™ 3.0 section of the support 
forums 

14. Export Excel - Export all signs that are in the found set to excel for client review. 
Related Tutorial: Exporting to Excel 

15. Import Excel - Import clients notes from originally exported excel file. 
Related Tutorial: Importing from Excel 

16. Send Email - Creates an email based on the contents of the Notes field of the current record. 
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17. SYNC - Press SYNC when prompted by InDesign. 
18. Reports - Click Reports to access the reports navigator. 

Related Tutorials: REPORTS 

Page 54SignAgent Pro 4.0

https://signagent.zendesk.com/hc/en-us/sections/202595083-REPORTS


TYPE 
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TYPE Sorting Options 
This tutorial provides an overview of the way TYPES are sorted in SignAgent Pro™. 

1. No Sorting - It is not possible to sort the signs by using the field headers. 
2. Up - Use this button to move the record Up in the order. The order of the Types in this table is 

the order they appear in Reports and in the InDesign Edit Script. 
3. Down - Use this button to move the record Down in the order. The order of the Types in this 

table is the order they appear in Reports and in the InDesign Edit Script. 
4. Sort Order: As shown. 
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TYPE Table Overview 
This article gives an overview of the different fields in the TYPE Table and where they are used in 
SignAgent Pro™ 

1. Type - This field gives the designation for the sign type. This is what will show up in the SIGN 
table, InDesign Sign Tags and in the Sign ID in all Reports. If a type is highlighted RED then it is 
MISSING - No signs in the database are currently using that sign type. If a type is highlighted 
YELLOW then it is a DUPLICATE - There are multiple sign types using the same designation. 

2. Description - This field displays the description of the sign type. This will show up in default 
message schedules, sign counts, and sign estimate reports. 

3. Drawing Number(s) - This field describes what drawing number is associated with this sign 
type... This will show up in default Sign Count, Sign Estimate, and Translated Message Schedule 
Reports 

4. Background Colour - This field describes the background colour of the sign... The dropdown 
list here is populated from the Colours tab in the SETTINGS table. The background colour here 
will also affect the background colour of your Sign IDs or Type Designations in all of your 
default reports. (If left blank, the default is white) 

5. Text Colour - This field describes the text colour on the sign... The dropdown list here is 
populated from the Colours tab in the SETTINGS table. The text colour here will also affect the 
text colour of your Sign IDs or Type Designations in all of your default reports. (If left blank, the 
default is black) 
For more information on adding colours, check out this article: Adding Colours to SignAgent Pro 

6. Trans - Check this box to allow for translations on this sign-type 
7. Hide - Check this box to hide this type from all reports. 
8. Notes - These fields are for additional notes regarding each type. Content from Notes 1 will 

appear on default Sign Count and Sign Estimate reports. 
9. Picture - Used to display a picture of this sign type. This will show up in the default Sign Count 

and Sign Estimate reports. 
10. Side - How many sides does the sign have? This will show up in the default Sign Count report. 
11. Power - Does this sign require power? This will show up in the default Sign Count report. 
12. Data - Does this sign require data? This will show up in the default Sign Count report. 

Page 57SignAgent Pro 4.0

https://signagent.zendesk.com/hc/en-us/articles/213265563-Adding-Colours-to-SignAgent-Pro-


13. Mount - How is this sign mounted? This will show up in the default Sign Count report. 
14. Unit Cost - What is the cost per sign of this type? This will show up in the default Sign Estimate 

Reports. 
15. Creation Information - Displays who created the sign and at what time (Green highlighted text 

means that this type was created today) 
16. Modification Information - Displays who last modified the sign and at what time (Green 

highlighted text means that this type was modified today) 
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TYPE Toolbar 
This tutorial provides an overview of the TYPE Toolbar used in SignAgent Pro™. 

1. TYPE - Press the TYPE button a second time to show either the "Secret" layout. 
2. New - Use to create a new Type. It will be added to the dropdown used to specify the Type in 

the SIGN table and in the InDesign Edit Script. 
3. Duplicate - Use to duplicate an existing Type. It will be added to the dropdown used to specify 

the Type in the SIGN table and in the InDesign Edit Script. 
4. Delete - Use to delete an existing Type. It will be removed from to the dropdown used to 

specify the Type in the SIGN table and in the InDesign Edit Script. 
5. Find - Use to find sets of information. 
6. Re-Find - Use if you didn't quite find what you wanted to with your last Find request. 
7. Show All - Use this button to show all records. 
8. Omit Hidden - Use this button to hide all the records that are marked as Hidden 
9. Up - Use this button to move the record Up in the order. The order of the Types in this table is 

the order they appear in Reports and in the InDesign Edit Script. 
10. Down - Use this button to move the record Down in the order. The order of the Types in this 

table is the order they appear in Reports and in the InDesign Edit Script. 
11. Export Excel - Export all signs that are in the found set to excel. 
12. Email - Creates an email. 
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Import TYPE Table 
This tutorial will teach you how to import a TYPE table from one SignAgent Pro™ file to another 
using the "Import TYPE table" command. 

1. Identify your 2 SignAgent Pro™ Folders 

Let's say you're looking to import the TYPE table from project SignAgentPro-1 to project 
SignAgentPro-2... 

Open up the following folders: 
1. SignAgent Pro-1 
2. SignAgent Pro-2 
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2. Copy & Rename Database 1 

1. Copy database from SignAgentPro-1 (green) into the SignAgentPro-2 folder (red) 
2. Rename SignAgentPro-1 database to OLD.fmp12 
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3. Open Files 

In the SignAgentPro-2 folder (RED), do the following... 

1. Open up OLD.fmp12 file 
2. Open up SignAgentPro-3.fmp12 
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4. OLD.fmp12 - Show All Records in TYPE Table 

In OLD.fmp12, do the following 

1. Go to TYPE table 
2. Click Show All 
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5. SignAgentPro-3.fmp12 - Import TYPE Table 

In SignAgentPro-3.fmp12, (in the SignAgentPro-2 folder still) do the following: 

1. Go to the TYPE table 
2. Go to File > Import TYPE Table 

6. Make a Choice... 

You can choose to delete existing Types or not... choose accordingly. 

Page 64SignAgent Pro 4.0



Complete! 

All the Sign Types from your first database have now been successfully imported into the second 
database! 

Note that this will only import the Sign Types into the TYPE table... it will NOT import any related 
signs into the SIGN table 
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LEVEL 
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LEVEL Sorting Options 
This tutorial provides an overview of the way LEVELS are sorted in SignAgent Pro™. 

1. No Sorting - It is not possible to sort the signs by using the field headers. 
2. Up - Use this button to move the record Up in the order. The order of the Levels in this table is 

the order they appear in Reports and in the InDesign Edit Script. 
3. Down - Use this button to move the record Down in the order. The order of the Levels in this 

table is the order they appear in Reports and in the InDesign Edit Script. 
4. Sort Order: As shown. 

Note: If you add a level to the LEVEL table by entering it into the level field in the SIGN table, it will 
be placed into alphabetical order in the LEVEL table. You can then rearrange it how you please. 
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LEVEL Toolbar 
This tutorial provides an overview of the LEVEL Toolbar used in SignAgent Pro™. 

1. New - Use to create a new Level. It will be added to the dropdown used to specify the Level in 
the SIGN table and in the InDesign Edit Script. 

2. Duplicate - Use to duplicate an existing Level. It will be added to the dropdown used to specify 
the Level in the SIGN table and in the InDesign Edit Script. 

3. Delete - Use to delete an existing Level. It will be removed from to the dropdown used to 
specify the Level in the SIGN table and in the InDesign Edit Script. 

4. Find - Use to find sets of information. 
5. Re-Find - Use if you didn't quite find what you wanted to with your last Find request. 
6. Show All - Use this button to show all records. 
7. Omit Hidden - Use this button to hide all the records that are marked as Hidden 
8. Up - Use this button to move the record Up in the order. The order of the Levels in this table is 

the order they appear in Reports and in the InDesign Edit Script. 
9. Down - Use this button to move the record Down in the order. The order of the Levels in this 

table is the order they appear in Reports and in the InDesign Edit Script. 
10. Export Excel - Export all Levels that are in the found set to excel. 
11. Email - Creates an email. 
12. SUPPORT - Pressing SUPPORT will take you to the SignAgent Pro™ 3.0 Support Forums 
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PHASE 
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Working with Phases 
This tutorial will give a quick overview of working with the PHASE table in SignAgent Pro™ 3.0 

PHASE Table 

1. Phase - This is the title of each Phase... this is how it will be displayed in the SIGN table, InDesign 
dropdowns, and default report headers and subsets. 
2. Issued Date - This is the date that the Phase is to be issued on... this is how it will be displayed in 
default report headers and subsets. 
3. Revision ID - This is meant to display the number of revisions that have occurred in each phase... 
this is how it will be displated in default report headers. 
4. Active - The phase that the project is currently in should be marked as "Active" using the 
checkbox... Whichever phase is marked as "Active" will be featured in the header of all default 
reports, with information from Phase, Issued Date, and Revision ID 
5. Hide - Any phase marked "Hide" will not show up on any of your default reports. 
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Phase Info on Reports 

1. Phase 
2. Issued Date 
3. Revision ID 

Note that Phases will appear on reports in the order that they appear in the PHASE table... 

See here: PHASE Sorting Options 

Also note that the sub-headers for Phase/Status will only appear if you choose a report option that 
is sorted by Phase/Status 
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PHASE Sorting Options 
This tutorial provides an overview of the way PHASES are sorted in SignAgent Pro™. 

1. No Sorting - It is not possible to sort the signs by using the field headers. 
2. Up - Use this button to move the record Up in the order. The order of the Phases in this table is 

the order they appear in Reports and in the InDesign Edit Script. 
3. Down - Use this button to move the record Down in the order. The order of the Phases in this 

table is the order they appear in Reports and in the InDesign Edit Script. 
4. Sort Order: As shown. 

NOTE: Any Phase that is added by typing it in manually in the SIGN table will first be sorted 
alphabetically. You can then rearrange it however you please. 
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PHASE Toolbar 
This tutorial provides an overview of the PHASE Toolbar used in SignAgent Pro™. 

1. New - Use to create a new Phase. It will be added to the dropdown used to specify the Phase 
in the SIGN table and in the InDesign Edit Script. 

2. Duplicate - Use to duplicate an existing Phase. It will be added to the dropdown used to 
specify the Phase in the SIGN table and in the InDesign Edit Script. 

3. Delete - Use to delete an existing Phase. It will be removed from to the dropdown used to 
specify the Phase in the SIGN table and in the InDesign Edit Script. 

4. Find - Use to find sets of information. 
5. Re-Find - Use if you didn't quite find what you wanted to with your last Find request. 
6. Show All - Use this button to show all records. 
7. Omit Hidden - Use this button to hide all the records that are marked as Hidden 
8. Up - Use this button to move the record Up in the order. The order of the Phases in this table is 

the order they appear in Reports and in the InDesign Edit Script. 
9. Down - Use this button to move the record Down in the order. The order of the Phases in this 

table is the order they appear in Reports and in the InDesign Edit Script. 
10. Export Excel - Export all Phases that are in the found set to excel. 
11. Email - Creates an email. 
12. SUPPORT - Pressing SUPPORT while in the PHASE layout will take you to the SignAgent Pro™ 

3.0 tutorial forums 
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STATUS Sorting Options 
This tutorial provides an overview of the way STATUSES are sorted in SignAgent Pro™. 

1. No Sorting - It is not possible to sort the signs by using the field headers. 
2. Up - Use this button to move the record Up in the order. The order of the Statuses in this table 

is the order they appear in Reports and in the InDesign Edit Script. 
3. Down - Use this button to move the record Down in the order. The order of the Statuses in 

this table is the order they appear in Reports and in the InDesign Edit Script. 
4. Sort Order: As shown. 
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STATUS Toolbar 
This tutorial provides an overview of the STATUS Toolbar used in SignAgent Pro™. 

1. New - Use to create a new Status. It will be added to the dropdown used to specify the Status 
in the SIGN table and in the InDesign Edit Script. 

2. Duplicate - Use to duplicate an existing Status. It will be added to the dropdown used to 
specify the Status in the SIGN table and in the InDesign Edit Script. 

3. Delete - Use to delete an existing Status. It will be removed from to the dropdown used to 
specify the Status in the SIGN table and in the InDesign Edit Script. 

4. Find - Use to find sets of information. 
5. Re-Find - Use if you didn't quite find what you wanted to with your last Find request. 
6. Show All - Use this button to show all records. 
7. Omit Hidden - Use this button to hide all the records that are marked as Hide 
8. Up - Use this button to move the record Up in the order. The order of the Statuses in this table 

is the order they appear in Reports and in the InDesign Edit Script. 
9. Down - Use this button to move the record Down in the order. The order of the Statuses in 

this table is the order they appear in Reports and in the InDesign Edit Script. 
10. Export Excel - Export all Statuses that are in the found set to excel. 
11. Email - Creates an email. 
12. SUPPORT - Pressing SUPPORT while in the STATUS layout will take you directly to the online 

tutorials for SignAgent Pro™ 3.0 
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TRANSLATION 
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TRANSLATION Sorting Options 
This tutorial provides an overview of the TRANSLATION sorting options in SignAgent Pro™. 

1. Primary Phrase - Press the header to toggle through different sort options (Unsorted and 
Primary Phrase). 

2. Translated Phrase - Press the header to toggle through different sort options (Unsorted and 
Translated Phrase). 

3. Creation Information - Press the header to toggle through different sort options (Unsorted
and Creation Timestamp). 

4. Modification Information - Press the header to toggle through different sort options 
(Unsorted and Modification Timestamp). 
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TRANSLATION Toolbar 
This tutorial provides an overview of the TRANSLATION Toolbar used in SignAgent Pro™. 

1. New - Use to create a new Primary Phrase. These values will be auto generated based on text 
input into the Message field in the SIGN layout. 

2. Delete - Use to delete an existing Primary Phrase. Phases marked as Red are not currently 
being used and therefore can be deleted. 

3. Find - Use to find sets of information. 
4. Re-Find - Use if you didn't quite find what you wanted to with your last Find request. 
5. Find Missing - Use to find fields marked as Red or Missing. This searchs for missing 

information in the Sign ID fields, Phase and Status fields. 
6. Find Duplicate - Use to find fields marks as Yellow or Duplicated. This searchs for duplicated 

information in the Sign ID field combinations. 
7. Show All - Use this button to show all records. 
8. Export Excel - Export all Translations that are in the found set to excel. 
9. Import Excel - Import Translations from originally exported excel file. 

10. UPDATE - Press to update Translations in the SIGN table based on the values input in the 
Translated Phase field. 

11. TURN OFF - Press to disable Translations if the project does not require Translations. 
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DEFECT 
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DEFECT Replacing Options 
This tutorial provides an overview of the SIGN field content replacement options in SignAgent 
Pro™. 

1. Type - Replace - Press button to replace all the Type fields in the current found set with the 
current field contents. There is a dialog that explains this process before committing the 
change. 

2. Level - Replace - Press button to replace all the Level fields in the current found set with the 
current field contents. There is a dialog that explains this process before committing the 
change. 

3. Number - Serial Replace - Press button to serial replace all the Number fields in the current 
found set. There is a dialog that explains this process before committing the change. 

4. Defect - Replace - Press button to replace all the Defect fields in the current found set with the 
current field contents. There is a dialog that explains this process before committing the 
change. 

5. Recommendation - Replace - Press button to replace all the Recommendation fields in the 
current found set with the current field contents. There is a dialog that explains this process 
before committing the change. 

6. Notes - Replace - Press button to replace all the Notes fields in the current found set with the 
current field contents. There is a dialog that explains this process before committing the 
change. 

7. Clients Notes - Replace - Press button to replace all the Clients Notes fields in the current 
found set with the current field contents. There is a dialog that explains this process before 
committing the change. 

8. Internal Notes - Replace - Press button to replace all the Interal Notes fields in the current 
found set with the current field contents. There is a dialog that explains this process before 
committing the change. 

9. Quantity - Replace - Press button to replace all the Quantity fields in the current found set 
with the current field contents. There is a dialog that explains this process before committing 
the change. 

10. Phase - Replace - Press button to replace all the Phase fields in the current found set with the 
current field contents. There is a dialog that explains this process before committing the 
change. 
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11. Status - Replace - Press button to replace all the Status fields in the current found set with the 
current field contents. There is a dialog that explains this process before committing the 
change. 
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DEFECT Sorting Options 
This tutorial provides an overview of the SIGN sorting options in SignAgent Pro™. 

1. Type - Press the header to toggle through different sort options (Unsorted, Detailed | Type 
and Type). 

2. Level - Press the header to toggle through different sort options (Unsorted, Detailed | Level, 
Number and Level, Number). 

3. Number - Press the header to toggle through different sort options (Unsorted, Detailed | 
Number, Level and Number, Level). 

4. Defect - Press the header to toggle through different sort options (Unsorted, Detailed | 
Defect and Defect). 

5. Recommendation - Press the header to toggle through different sort options (Unsorted, 
Detailed | Recommendation and Recommendation). 

6. Notes - Press the header to toggle through different sort options (Unsorted, Detailed | Notes 
and Notes). 

7. Clients Notes - Press the header to toggle through different sort options (Unsorted, Detailed 
| Clients Notes and Clients Notes). 

8. Internal Notes - Press the header to toggle through different sort options (Unsorted, Detailed 
| Internal Notes and Internal Notes). 

9. Pictures - No Sorting 
10. Quantity - Press the header to toggle through different sort options (Unsorted, Detailed | 

Quantity and Quantity). 
11. Phase - Press the header to toggle through different sort options (Unsorted, Detailed | Phase 

and Phase). 
12. Status - Press the header to toggle through different sort options (Unsorted, Detailed | 

Status and Status). 
13. Creation Information - Press the header to toggle through different sort options (Unsorted, 

Detailed | Creation Timestamp and Creation Timestamp). 
14. Modification Information - Press the header to toggle through different sort options 

(Unsorted, Detailed | Modification Timestamp and Modification Timestamp). 
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DEFECT Toolbar 
This tutorial provides an overview of the DEFECT Toolbar used in SignAgent Pro™. 

1. DEFECT - Press the DEFECT button a second time to show the expanded DEFECT layout. 
2. New - Use to create a new sign. When synchronized with InDesign this sign will appear in a new 

layer in the top right corner of the active page. 
3. Duplicate - Use to duplicate an existing sign. When synchronized with InDesign this sign will 

appear in a new layer in the top right corner of the active page. 
4. Delete - It is not possible to delete in FileMaker Pro. Use To Button (11) to find the sign in 

InDesign and delete in InDesign. 
5. Find - Use to find sets of information. For example: Press Find Button and then input Phase 2 

into the Phase field to find all Phase 2 signs. 
6. Re-Find - Use if you didn't quite find what you wanted to with your last Find request. 
7. Find Missing - Use to find fields marked as Red or Missing. This searchs for missing 

information in the Sign ID fields, Phase and Status fields. 
8. Find Duplicate - Use to find fields marks as Yellow or Duplicated. This searchs for duplicated 

information in the Sign ID field combinations. 
9. Show All - Use this button to show all records. 

10. Omit Hidden - Use this button to hide all the records that are marked as Hidden. Records can 
be marked as Hidden one of three ways. Either the sign's Level, Phase or Status is marked as 
being hidden in there related tables. 

11. To - Use this button to automatically copy the Sign ID into the computer's clipboard. The Sign 
ID can then be paste into the find dialog in InDesign to pinpoint the exact location. 

12. From - Use this button after you've copied the Sign ID from InDesign into the computer's 
clipboard. Pressing this button will automatically perform a find based on the contents of the 
computer's clipboard. 

13. Export Excel - Export all signs that are in the found set to excel for client review. 
Related Tutorial: Exporting to Excel 

14. Import Excel - Import clients notes from originally exported excel file. 
Related Tutorial: Importing from Excel 

15. Send Email - Creates an email based on the contents of the Notes field of the current record. 
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16. SYNC - Press SYNC when prompted by InDesign. 
17. Reports - Select "Reports" to select what Report you want to generate. 
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REPORTS 
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Changing Header information in Default 
Reports 
The default reports in SignAgent Pro™ contain a lot of useful information in the headers; but it can 
be a bit confusing to change that text if you don't know where to look. 

Category 1: Project Specific Text (SETTINGS Table) 

The first category of header text is PROJECT SPECIFIC. This is text that will not change throughout 
the whole project, or at least will not be phase specific. 

1. Report Label: This text depends on the report, and is hard-coded in. If you want to change it, go 
into layout mode and change the text. 
2. Job Number: This represents the job number for the specific project. It can be found in the 
SETTINGS table (see below) 
3. Disclaimer: This is a disclaimer for whomever is receiving this report. It can be found in the 
SETTINGS table (see below) 
4. Title: This represents the title for the project. It can be found in the SETTINGS table (see below) 
5. Subtitle: This represents the sub-title for the project. It can be found in the SETTINGS table (see 
below) 
6. Phase Identifier: This is the text chosen to identify the ACTIVE PHASE. It can be found in the 
SETTINGS table (see below) 
7. Revision Number Identifier: This is the text chosen to identify the Revision Number of the ACTIVE 
PHASE. It can be found in the SETTINGS table (see below) 
8. Issued Date Identifier: This is the text chosen to identify the Issued Date of the ACTIVE PHASE. It 
can be found in the SETTINGS table (see below) 

Page 88SignAgent Pro 4.0



Category 2: Phase Specific Text (PHASE Table) 

The second category of header text is PHASE SPECIFIC. This is text that will change based on the 
ACTIVE PHASE. 
See this tutorial for more information on the Active Phase: Updating Active Phase Information 

1. Active Phase: This shows the Phase that is currently marked active. This is found in the PHASE 
Table (see below) 
2. Revision Number: This shows the Revision Number of the Phase that is currently marked active. 
This is found in the PHASE Table (see below) 
3. Issued Date: This shows the Issued Date of the Phase that is currently marked active. This is 
found in the PHASE Table (see below) 

NOTE: The information will only be displayed for the Phase that is currently marked as ACTIVE. 
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Formatting Basics 
This tutorial will go over the basics of formatting your reports in FileMaker by using the Inspector 
tool 

Before we begin, a note: this is not meant to be a comprehensive guide on how to create layouts in 
FileMaker... there are some very complex formatting options available which we will not be going 
over... if you're interested in more in-depth information, we recommend you check out either of 
the following... 
FileMaker Web site: FileMaker Training Series 
Lynda tutorials: FileMaker Training and Tutorials | Lynda.com 

1. Editing on screen directly 

There's a couple of useful things to note before moving on to the Inspector tool. 

1. Rulers: Pretty self-explanatory... you can change the units by clicking on "in" in the top-left 
corner. You can also create guide-lines by clicking and dragging from these rulers. 
2. Header: This is the area that will appear at the top of every page... by default it will contain 
3. Leading Sub-Summary(s): These areas define what the summary breaks will look like... For 
example, these define how the phase or status breaks will look IF you sort by phase and/or 
status... if you delete these you will be unable to do sub-sorts (phase, status, etc.) 
4. Body: This is the main area with all your information... you'll notice that all of the fields are way 
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taller than they need to be, but they will shrink based on the amount of content in the fields (this is 
denoted by the upward facing arrows at the bottom of the fields) 
5. Trailing Grand Summary: This is the summary that will show up at the end of your report. It 
could be a total quantity count or a cost total or some other value. 
6. Footer: This is the area that will appear at the bottom of every page... by default it contains 
areas for page counts and a logo 
7. Dotted Lines: These indicate the page breaks... if the layout continues past these marks it will 
bleed onto the next page. You can find more information about sizing reports here: (Change the 
Page Size of your Reports) 

Fields here can be moved and resized in the normal way, by clicking and dragging, etc... 
To add new fields, it's best to take them from the Starter layout... for more details on that, check 
out this tutorial: (COMING SOON) 

Adding other features 

1. Show or hide the status toolbar: Click on this to show the status toolbar (red box) 
2. Basic features tools: from left to right: Select, Text, Line, Rectangle, Rounded Rectangle, Oval. To 
use these, just select the tool and click in the layout. Nothing more to it. 
3. More advanced features tools: these tools involve data from other tables or layouts in SignAgent 
Pro™ and should probably be avoided unless you're an expert or willing to experiment a bit. 
From left to right: Field/Control, Button/Popover Button, Tab Control/Slide Control, Portal, Chart, 
Web Viewer, Add Field, Add Part, Format Painter 

These features can all also be found in the Insert menu. 
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The Inspector: Position Tab 

The most useful tool in our formatting arsenal is the Inspector. It contains all the most important 
formatting tools and options for editing parts, objects, and fields in the layout. 
You can access the Inspector by pressing command + i (ctrl + i on PC) on by going to View > 
Inspector 

1. Here you can provide whichever field you've selected with a name and a tooltip 
2. Here you can set the exact position of the field or part from the origin (0, 0; the top-left corner) 
3. Here you can set the exact size of the field. By default, this size is adjusted from the top and left 
edges. This default can be changed in the Autosizing part below 
4. Here you can decide how the resizing of fields will occur... by default it is from the top and left 
edges, but you can change that here. 
5. Here you can change the alignment... to use this you must have multiple objects selected. 
6. Here you can adjust the spacing of the objects. These tools will make for even spacing between 
objects. 
7. Here you can resize the objects... to use this you must have multiple objects selected. 
8. Here you can change grouping options... to use this you must have multiple objects selected. 
9. Here you can lock or unlock the objects selected. 
10. Here you can change the order of arrangement of the objects. 
11. These options allow you to remove blank space by sliding content up or left (this is why the 
objects in the report are taller than necessary) It will automatically resize the object based on the 
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content contained. You can also change the visibility of objects when printing. 
12. Here you can change grid options... visibility, major and minor grid lines, etc. 

The Inspector: Appearance Tab 

You'll notice we skipped the Styles tab... This tab will only show up in FileMaker Pro 13, and is just a 
list of different styles you may have saved. 

1. Here you can set Styles and Themes... if you set a certain style of formatting that you like, you 
can save it for later use. 
2. Here you can set basic graphic options, such as background fill colour, outline and line colour, 
and corner radius. 
3. Here you can set Advanced Graphics options, such as shadows and padding from the edges 
4. Here you can set Text options, pretty self-explanatory 
5. Here you can set paragraph options, from basic alignment options to spacing between lines and 
indent options. 
6. Here you can set manual tab widths in messages. 
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The Inspector: Data Tab 

1. Data: This outlines exactly what is being displayed, and what table it is being taken from. 
2. Control Style: This describes what sort of object this is 
3. Behaviour: This outlines what sort of behaviour this object has in different modes (Preview, 
browse, find, etc.) 
4. Data formatting: This is used mainly for formatting images; it will effect how it is cropped and 
how it is aligned. 

Page 94SignAgent Pro 4.0



How to Customize a Report 
This tutorial will go over the steps of how to customize an existing report in SignAgent Pro™ 3.0 

1. Open up the Report to Customize 

1. Go to the SIGN table 
2. Click on "Reports" 

1. Select the Report that you would like to Edit (don't worry about the sort order... you can see the 
tutorial on how to change sorting orders here: How to Add a New Sorting Option) 
The active report is the one highlighted in green. We'll be using a Message Schedule as an 
example. 
2. Click Edit. 
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In the window labeled "Reports", click where it says "Preview" (near the bottom-left corner of the 
window) and select "Layout" in the drop-down menu. 
You could also press command+L on Mac or ctrl+L on PC 
This will put you into Layout mode, which is where you can edit the report. 

2. Make the Necessary Changes 

For this example, let's say that we want to remove the "Drawing" field and replace it with "Internal 
Notes" 

This is the default Message Schedule report in layout mode... obviously it looks a little bit 
different... You can get an overview of this mode in this article: Formatting Basics 
Before we do anything, let's make a Duplicate of this layout to keep it separate from the default... 
you can see how to do that here: Duplicating an Existing Report 

In order to change the "Drawing" field to the "Internal Notes" field, we have to do 2 things. 
1. Change the heading from Drawing to Internal Notes 
2. Change the field itself from Drawing to Internal Notes 
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Step 1 is easy... simply double-click on the heading and change the text from "Drawing" to "Internal 
Notes" 
Step 2 has a couple different options... 

Option 1: Copy the field from the Starter Layout 

This is probably the simplest option, though maybe not the quickest... 

Here's how to do this: 

1. While in the Reports window, open a new window by going to Window > New Window 
2. Switch that new window to the Starter layout by selecting it from the drop-down menu 
3. Copy the Internal Notes field and Paste it into your report. Then format it as you choose! 
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Option 2: Change the field type in the report 

This option is quicker if you know where to look. 
You can also change the contents of a field directly; this will keep all of its existing formatting, 
location, etc. 

1. Double-click on the field you would like to change 
2. Find the related table in the drop-down (eg. Internal notes are found on the SIGN table, so you'll 
look in "brSign" 
3. Select the field you would like to change to 
4. Click OK 

You can then also rearrange and format how you please. 
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Change the Page Size of your Reports 
This tutorial will teach you how to adjust the page sizes of your reports in SignAgent Pro™. In this 
example, we'll be creating a layout to view your message schedule in landscape, rather than 
portrait. 

The first thing you should do is get into layout mode and duplicate the report you're adding a page 
size for. This way, even if you mess up, you still have your reports, and you sitll have your report at 
the original page size for later use. 

You can see a tutorial on how to do that here: Duplicating an Existing Report 

(The only exception to this is if you're just using a longer paper size, such as 8.5" x 14" paper. Then 
you can skip down to step 3.) 

1. Adjust the Layout Width 

Once you've duplicated the report you'd like to edit, you can go into the layout and make any 
changes you'd like... 

The first thing you should probably do is adjust the width of the body. You can do that by 
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1. Open up the Inspector by going to View > Inspector 
2. Click in the white space (or not having anything selected) in Layout mode 
3. Adjust the width value to whatever you like. (We're going to use 11 inches here) 

Note that you don't have to change the height of the body, since these fields are automatically 
resized in SignAgent Pro's reporting. 

2. Adjust the Layout 

Next, make any changes to the layout that you'd like... in this example, we'll just be widening all the 
columns, but you could add more columns or other items as you please. 

Don't forget details like divider lines! They might seem small, but they'll make your report look silly 
if you don't update the width on them! 
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3. Add New Report to the REPORTS Table 

Next, you'll want to add your new report to the REPORTS table... 

1. Go to the REPORTS Table 
2. Add your new report to the table (It's easiest to duplicate an existing report's records! We 
duplicated the Message Schedule records) 
    Go back to the Duplicating an Existing Report tutorial for more detail on this! 
3. Change the Page Size to the desired value (we used 11" x 8.5") 
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Complete! 

You now have a report that can be printed or presented on a different page size. How grand! 
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How to Add a New Sorting Option 
This tutorial will walk you through exactly how to add a new option for sorting your reports in 
SignAgent Pro™ 3.0. It may seem complicated, but is actually very easy if you just follow these 
steps. 

1. Get into the Report Editing Layout 

In the SIGN Table... 
1. Click on Reports 
2. Click on Edit in the Navigator window 
3. Go to Scripts > Manage Scripts (or press Shift + Command + S on Mac or Shift + Ctrl+ S on PC) 
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2. Open up the Script file__sortSize___report 

1. Select file__sortSize__report by clicking on it in the list on the left. 
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3. Duplicate an existing Sorting Option 

1. Find an existing sorting option in the Script, similar to seen above... (you can select multiple lines 
by clicking on the first line and then holding Shift and clicking on the second line) 
The first line should start with Else If [$reportSort = 
The second line should say Sort Records [Restore; No dialog] 
2. Duplicate these lines by going to Edit / Duplicate Step or by pressing cmd+D on Mac or ctrl + D 
on PC 
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4. Modify Line 1 (Sorting Description) 

1. Double-click on the first line of your newly duplicated text 
2. In the Specify Calculation dialog box, modify the text in quotation marks. You can make this 
whatever you like, but you must match it EXACTLY in the REPORTS table 
3. Click OK 

5. Modify Line 2 (Record Sorting) 

1. Double-click on the second line of text (Sort Records [Restore; No dialog]) 
2. Place the options in the Sort Order box in the order you would like them. (Note that in the order 
specified above that signs will be sorted by Level, then Type, then Number) 
3. If you don't see the one you're looking for, find it in here (Go to the respective table, and then 
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select ::Order) 
4. Click OK 

6. Exit and Save the Script 

You can now exit out of the Edit Script dialog box. NOTE that when it asks you if you want to save, 
press Save! 

You can also exit out of the Manage Scripts dialog box and the Reports dialog box until you are 
back at the SIGN table 

7. Choose your Sorting option in the REPORTS table 

1. Go to the REPORTS table 
2. Enter your Sort Order EXACTLY as you did in Step 4 

Complete! Your reports will now be sorted in a new order! 

Page 107SignAgent Pro 4.0



Change Report Order for Navigator 
Below is the step by step instructions on how to change the order of the reports for the navigator. 

Step by Step Instructions 

1. Choose: REPORTS 
2. Press: UP to move the selected report up the list. 
3. Press: Down to move the selected report down the list. 

Result 

The Reports will be sorted in the same order as the REPORTS Table. 
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Duplicating an Existing Report 
It's often a good idea to make a duplicate of a report layout before serious editing...This tutorial 
will teach you how to duplicate an existing report, change the name, and properly integrate it into 
your REPORTS table. 

In this example, we're going to make a copy of our regular message schedule to create a visual 
message schedule by replacing the Message Field with the first Picture field 

1. Go into Report Layout Mode 

In the SIGN table... 

1. Click --Reports-- 
2. Select the Report you'd like to Duplicate... In this example, let's choose the Message Schedule. 
(Note that you can pick whichever sort order you like, it doesn't matter) 
3. Click Edit 
4. Click "Preview" and select "Layout" from the drop-down list. (Alternatively, you can press 
command + L on Mac or ctrl + L on PC) 
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2. Go to Manage Layouts 

Once you're in Layout mode for your selected Report... 

1. Click the button to Show the Status Toolbar 
2. Where the name of your current layout is displayed, choose Manage Layouts... from the drop-
down list. 
Alternatively, you can go to View > Go to Layout > Manage Layouts 
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3. Duplicate the Layout 

In the Manage Layouts dialog box... 

1. Select the layout you'd like to duplicate (Message Schedule, for this example) 
2. Click Duplicate 
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4. Edit the New Layout Title 

1. Select the duplicated layout (it should have the original layout name followed by "Copy") 
2. Click Edit 
3. Change the layout name to whatever you like. 
4. Click OK 
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5. Go to the New Layout and start Editing! 

NOTE: You are NOT currently in your new layout... you need to make sure you actually switch to 
your newly created layout before making any changes. To do this... 

1. Click the Layout Title, and in the drop-down list that shows up, and under Reports, choose your 
new Layout. 
Alternatively, you can go to View > Go to Layout > Reports > and choose your new Layout. 

2. Make any changes that you'd like! 
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6. Making any changes that you like. 

In case you're interested in following this example through, here's what I did to make this into a 
more visual message schedule... 

1. Changed the title in the header to "Visual Message Schedule" (double-click on the merge field, 
and just change the text) 
2. Changed the header for the 2nd column to "Picture" (double-click on the text field, and change 
the text) 
3. Changed the field for the 2nd column to "Picture2", which is the 1st picture column. (double-click 
on the field and select Picture2) 
I also reduced the height of the field, and set the picture alignment to "Top" (In the inspector (cmd 
+ I), under the Data tab, near the bottom, under "Data Formatting", change the Alignment 
4. Deleted the existing "Picture" field, (Selected Picture field and pressed delete) and moved the 
thin grey line up to just below the end of the existing fields. (Just click and drag... if you hold shift, it 
will maintain its horizontal position.) 
5. Reduced the height of the body. (Select the body section by clicking where it says "Body" and 
then adjust the height in the Position tab in the Inspector. Alternatively, just click the bottom edge 
of the body field and drag upwards) 

Make sure you check how the report looks visually by switching back to Preview mode (cmd + U) 
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7. Add to the REPORTS Table 

The final step is to add your new layout to the REPORTS table. 

1. Name: You can call your new Report whatever you like! This is how it will be displayed in the 
Navigator window when you click --Reports-- in the SIGN Table 
2. Layout: Choose your new layout from the drop-down list here. It's best to choose from the list, 
as the name must match your layout name exactly. 
3. Page Size: The Size that your report will display and print at. 
4. Sort Order: Add a new record (row) for each sort-order you'd like to include. You can just pick 
from the drop-down list when you click in the field. 
5. Notes: Any notes you'd like to add for future reference. 

COMPLETE! 

Your new Visual Message Schedule report is now featured in the Navigator, and you didn't lose 
your old Message Schedule. What a great day! 
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Hide Report from Navigator 
Below is the step by step instructions on how to hide a report from the navigator. 

Step by Step Instructions 

1. Choose: REPORTS 
2. Check off Reports that you do not want to appear in the navigator 

Result 

1. The Report sorted by: Phase/Status/Type/Level/Number is not in the Navigator. 
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PDF Report 
Below is the step by step instructions on how to PDF a report. 

Step 1 

1. Press: SIGN 
2. Press: Reports 

Step 2 

1. Choose the report you would like to prepare (green is the active report) 
2. Press: PDF to export the report as a PDF. 
3. Press: Done to close the Navigator. 
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Make Your Reports Sub-Sort by Type 
This tutorial will teach you how to replace your Phase sub-headers with Type sub-headers, 
allowing you to separate out your types more in your message schedules. 
Currently, this will also put each Type on a separate page. 

1. Duplicate Existing Message Schedule Report Layout 

The first thing you should do is make a duplicate report of your Message Schedule, and call it 
"Message Schedule Type Sort" with the Sort Order of "Type/Level/Number" 

For details on how to duplicate reports, check out this tutorial here: Duplicating an Existing Report 

2. Enter Layout Mode for Message Schedule Type Sort 

1. Go to the SIGN Table 
2. Click Reports 
3. Select "Message Schedule Type Sort" 
4. Click Edit 
5. Change Mode from Preview to Layout (View > Layout, or press command+L) 
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3. Edit the Report Sub-Summary 

1. Double-click on the Phase Sub-Summary Part Label 
2. Change the related Table to brType 
3. Select ::Order 
4. Click OK 
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4. Edit the Sub-header Text 

1. Double-click on the textbox containing the text "<<brPhase::Phase>> - <<brPhase::Date>>", and 
double-click the text so that you're in text editing mode. 
2. Select the text that you'd like to replace 
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5. Choose new Merge Fields 

1. Go to Insert > Merge Field... 
2. Change the table that you're choosing from to brType 
3. Select ::Type (or whatever other field you'd like to add... 
4. Click OK 

Note that in our example, the text in this textbox now reads <<brType::Type>> - 
<<brType::Description>> to show the Type and Description for each type (with a dash in the 
middle) 
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Complete! 

We now have a report that includes each different type in its own separate sub-sort and page. 
Awesome! 
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Print Report 
Below is the step by step instructions on how to print a report. 

Step 1 

1. Press: SIGN 
2. Press: Reports 

Step 2 

1. Choose the report you would like to prepare (green is the active report) 
2. Press: Printer to print the report to a printer. 
3. Press: Done to close the Navigator. 
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Merge Fields in Reports 
This tutorial will explain merge fields, and give an example on how to modify them. 

Merge Fields 

Merge Fields are special fields in FileMaker layouts (such as SignAgent Pro™ Reports) that will 
combine multiple fields from your SignAgent Pro™ database into one field in your layout. 

For example, the Sign ID field is actually a field combining Type + Divider 1 + Level + Divider 2 + 
Number 
In the merge field, this is displayed as <<Type>><<Div_1>><<Level>><<Div_2>><<Number>> 

In the example below, we will be removing the Level and Divider 2 fields from the Sign ID merge 
field. 

1. Open up the Report to Customize 

1. Fo to the SIGN Table 
2. Click on "Reports" 
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1. Select the Report that you would like to Edit (don't worry about the sort order... you can see the 
tutorial on how to change sorting order here: How to Add a New Sorting Option) 
The active report is the one highlighted in green. We'll be using a Message Schedule as an 
example. 
2. Click Edit. 

In the window labeled "Reports", click where it says "Preview" (near the bottom-left corner of the 
window) and select "Layout" in the drop-down menu. 
You could also press command+L on Mac or ctrl+L on PC 
This will put you into Layout mode, which is where you can edit the report. 
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2. Selecting the Merge Field 

To select the Sign ID Merge Field, simply click on it. To edit it, just double-click on it. 

Note that when you double-click to edit, the field may automatically expand so you can see all the 
text in the box. 
Also note that I've dragged the field downwards so we can better see the contents. 

3A. Deleting Contents from the Merge Field 

To delete contents, simply double-click on the merge field, select the contents you'd like to delete, 
and press delete or backspace. 
If position or size of the field has changed, you may have to move it back to the proper place. (This 
is made much easier by using the align and re-size tools in the Inspector) 
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You can see here that the Level and Div 1 contents have disappeared from every entry on the 
message schedule now. 

3B. Adding Contents to the Merge Field 

Now let's say we want to add the Level and Div 1 fields back into the merge field... 
First, double-click on the field to edit it again, and get your cursor where you want it. 
Then, go to Insert > Merge Field (as shown in the image above) 
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Then select the field you'd like to insert, and press OK. 
To add another field, simply do that process again. 

If position or size of the field has changed, you may have to move it back to the proper place. (This 
is made much easier by using the align and re-size tools in the Inspector) 

Voila! The level and div2 fields are back in there. 
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SETTINGS 
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Register SignAgent Pro™ File 
This tutorial will walk you through File Registration. If the file is not registered to a company it will 
open to the above screen. 

Your Registration String was emailed to the your companies main contact at the time of purchase 
or upgrade. 

Input Registration String 

1. Input Registration String here 
2. Press Register Button 
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Unregister SignAgent Pro™ Computer 
Use this option to unregister a computer from using SignAgent Pro™. This can be used in the event 
of getting a new computer, switching to a different machine, or a staff member no longer needing 
to use SignAgent Pro™. 

SETTINGS 

1. Select SETTINGS layout 

Unregister Computer 
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1. Select Unregister Tab 
2. Press [UNREGISTER THIS COMPUTER] Button 

Confirm Unregistration 

1. Press Unregister Button 

COMPLETE 

The file will automatically close. This will deactivate this computer's license from SignAgent Pro™, 
allowing you to activate on another machine. 
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Adding Colours to SignAgent Pro™ 
This tutorial will teach you how to add colours (or colors, if you're American) to your SignAgent 
Pro™ database. Colours are primarily used within the TYPE table, where they can be used to 
customize the background and text colours of the Sign ID in default reports. For more details on 
that, see here: 
TYPE Table Overview 

1. Go to the Colours Tab in the SETTINGS table 

1. Go to the SETTINGS tab 
2. Go down to Preferences and select Colours 
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2. Make the New Colour 

1. Select the blank entry (at the bottom of the list) 
2. Enter the name of your colour 
3. Enter your RGB Values (note that the thumbnail on the left will update to reflect these values) 
4. Enter any notes that you think are applicable. 

Note that you can remove a colour from the list by pressing the red X 
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Unregister SignAgent Pro™ File 
Use this option to transfer SignAgent Pro file to a second party. The second party must be a 
licensed SignAgent Pro™ user to open files. 

SETTINGS 

1. Select SETTINGS layout 
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Unregister File 

1. Select Unregister Tab 
2. Press [UNREGISTER THIS FILE] Button 

Confirm Unregistration 

1. Press Unregister Button 
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COMPLETE 

The file will automatically close. You can now transfer the files to a second party. 
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Upgrade to SignAgent Pro 4.0 
Follow the below steps to upgrade a SignAgent Pro™ 2.2.1, 2.3, 2.5, 2.5.1, 3.0, or 3.0.1 project to 
SignAgent Pro 4.0 

When upgrading to the latest version always work from copies. 

Update InDesign Scripts 

Click this link to find the latest compatible InDesign scripts and how to install them. 
Install Scripts 

Update InDesign Keyboard Shortcuts 

Click this link to find out how to create keyboard shortcuts in InDesign. 
Keyboard Shortcuts 

Download Files 

Click this link to find all necessary download files, as well as information on SignAgent Pro 4.0 
What's New in SignAgent Pro 4.0 
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Copy & Open Folders 

Open up the following folders: 

1. Latest version of SignAgent Pro™ found in dropbox folder (SignAgentPro-4_0-ISSUED) (GREEN) 
2. Older version of SignAgent Pro™ on computer (RED) 
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Copy & Rename Old Database 

1. Copy (RED) database to the same folder as (GREEN) database 
2. Rename (RED) database to "OLD.fmp12". 
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Delete New InDesign File 

1. Delete (GREEN) InDesign Files 

Page 141SignAgent Pro 4.0



Copy Old InDesign File 

Copy the old INDD file... This is the InDesign file that has all of the signs already place (RED) 
(Assuming that you haven't changed versions of InDesign since last time you opened this project, 
you shouldn't need any IDML files) 
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Copy Links AND Reports Folders 

Copy and replace the Links folder and the Reports folder (if your existing project folder has a 
Reports folder) 
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Open Files 

Open the following files in this order: 

1. OLD.fmp12 file 
2. InDesign file 
3. FileMaker Database (SignAgentPro-3.fmp12) 

NOTE: When you open up SignAgentPro-3.fmp12, you will be asked to enter your organization's 
registration string. You can get this from either 
a) Your office's main point of contact with SignAgent Pro™ staff 
b) SignAgent Pro™ support (send an email to support@signagent.com) 
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OLD.fmp - Show All & Unsort Records 

In OLD.fmp12 perform the following: 

1. Go to SIGN table 
2. Select: Show All Records 
3. Select: Unsort 

Repeat Steps 1 & 2 for: 

• TYPE table 
• LEVEL table 
• PHASE table 
• STATUS table 
• TRANSLATION table 
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Latest SignAgent Pro - Upgrade 

Latest SignAgent Pro™ (SignAgentPro-3.fmp12) 
Go to SETTINGS layout… 

1. Preferences (bottom left corner): 
2. Click on UPGRADE tab 
3. Press [UPGRADE] button 

Latest SignAgent Pro™ - Place .xsl Files 

Latest SignAgent Pro 
Go to SETTINGS layout… 

1. Preferences (bottom left corner): 
2. Click on Scripts tab 
3. Drag and drop from_FM.xsl from existing latest project folder XML/Internal Folder (if it's not 

already there) 
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4. Drag and drop from_ID.xsl from existing latest project folder XML/Internal Folder (if it's not 
already there) 

If the files already exist you do not have to perform this task. 

Delete OLD.fmp12 

1. Close and Delete OLD.fmp12 database 

Synchronize and Save 

IF you are upgrading from SignAgent Pro™ 2.5 or 2.5.1, run a Sync using Sync_3.jsxbin BEFORE running 
the new Sync script. If you don't already have it, you can download that here: Sync_3 

Run the new Sync script after closing down your old database, and then save the InDesign file. 

If you have any issues with the Sync, check out this tutorial: Sync Fix 
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COMPLETE 

If you are upgrading from version 2.3 or later, you are done! 

Upgrading from SignAgent Pro™ 2.2.1? 

If you are upgrading from 2.2.1 you will need to manually import the from_FM.xml file 
Contact support for further instructions. 
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SUPPORT 
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Submit Request for Support 
Please follow the below steps when submitting a Request for Support. 

Search Tutorials 

1. Tutorials - Browse the list of tutorials in the associated forum. 
2. Search - Enter text string you want to search for if you can't find the tutorial you are looking 

for. 
3. Submit a Request - If you can't find what you're looking for, use this button to submit a 

request to our amazing support team (see next step) 
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Submit a Request 

1. Email Address - Put your email address here, so we know who you are. 
2. Subject - Add a status of URGENT if this is an urgent matter. 
3. Description - Be as descriptive as possible. Include SignAgent Pro™, Operating System, 

FileMaker Pro and Adobe InDesign version numbers. 
4. Attachment(s) - Attach screen shots at the most here… If you have recorded your screen as a 

movie or the source files have been requested from support staff please upload to dropbox 
and make mention of location and filename in the description. Either drag and drop files onto 
this area, or click "Add File" to bring up the standard file selection interface 

5. reCAPTCHA - Check this box and complete any subsequent dialog to prove that you're human. 
This helps us reduce spam, which helps us provide better support. 

6. Submit - Press to submit the request. You will receive notification that your request has been 
received. 

Note that you can also submit a request to support@signagent.com 
Please follow the same suggestions above for subject, description, and attachments 
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InDesign 
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Why is there an .IDML file? 
If you are using an older version of InDesign, such as CS6 or an early version of CC, you will need to 
open the .IDML (InDesign Markup Language) file in the SignAgent Pro™ folder. 

Follow the steps below: 

1. Open .IDML file 

Open the IDML file directly from your SignAgent Pro™  folder. This can be done by double-clicking 
on it, or by right-clicking and selecting Open 

2. Result: Untitled-1 

Note that the file is called Untitled-1. 
In its current state, the SignAgent Pro™ scripts will not function properly. 

3. Save File 

1. Select: File 
2. Select: Save 

4. Replace Incompatible INDD file 

1. Click on SignAgentPro-3.indd 
2. This will automatically give your new file the name "SignAgentPro-3.indd", replacing the old, 

incompatible file. 
3. Make sure that you're choosing the correct document format for your version of InDesign, and 

choose document, not template. 
4. Save 

5. Write over existing file 

1. Press: Replace to overwrite existing, incompatible INDD file with your new correct file. 

6. 

Result - SignAgentPro-3.indd 
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Notice that the file is now properly saved as SignAgentPro-3.indd 

7. Remove .IDML File (optional) 

The .IDML file no longer has any use. You can delete it, if you so choose 

1. Right Click: SignAgentPro-3.idml 
2. Select: Move to Trash 

COMPLETE! 

You can now go about your SignAgent Pro™ related business normally and without worry. 
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Preparing PICT Location Plans 
Watch this tutorial to see how to best prepare your Location Plan PICT files. 

It will greatly increase the display performance of complex location plans in InDesign. 

Video 

SignAgentPro-PreparingLocationPlans from David Jorritsma on Vimeo. 
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How to Add Artwork in InDesign 
This tutorial will tell you how to display sign artwork from your SignAgent Pro™ database directly 
on your location plans in InDesign. 
Note that we have this feature supports images in PNG, JPG, and PDF formats, officially. Other 
image formats may work, but have not been tested extensively by SignAgent staff. 

1. Add Artwork in FileMaker 

There are 3 ways to do this... 

1. Right-click (or ctrl-click on Mac) in the Artwork field, and select Insert Picture. Then select the 
image from the dialog box that shows up. 
2. Select the image in Finder and copy it. Then select the Artwork field in FileMaker and paste. 
3. Click and drag the image from Finder into the FileMaker database. 

Note that if you'd like to move artwork around within FileMaker, you can click and drag to move it 
from record to record. You can also hold down option (alt on PC) and click and drag to duplicate 
the image. 

IMPORTANT NOTE: If you're looking for the image to add, do NOT take the image directly from the 
Links/Sign/Artwork folder in your SignAgent Pro™ folder. This creates a circular reference and a 
whole bunch of problems. 
ALSO ensure that no two images have exactly the same name. This also creates problems with 
referencing. 
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2. Sync 

Once you're images are in, start your Sync from InDesign. 

3. Expand your Sign Tags to see images 

After the sync is completed, you should be able to just expand your sign tags, and the images will 
appear! A couple of tips... 

1. PDFs give the best results, from our testing... they're the most reliable, and give good quality. As 
you can see, PNGs are a bit more dicey, depending on how they're prepared. 
2. You are able to resize the images in InDesign, but they will return to their original size when you 
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sync. Keep this in mind when you prepare your images. 
3. You may be interested in hiding any extraneous information, using the Style script... check out a 
tutorial on that here: Style - Hide Field in InDesign 
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Combining 2 SignAgent Pro™ Projects 
This tutorial will explain how to combine 2 SignAgent Pro™ projects together into 1. 

1. BACK UP YOUR FILES 

Whenever doing something unusual with your SignAgent Pro™ files, it is always wise to create a 
backup of your current projects in case you make an error or something goes wrong. So do that 
first! 

2. Opening Files 

To combine the SignAgent Pro™ files, we'll have to open up the following: 
1. The FileMaker database from your first folder. 
2. The InDesign Location Plan from your first folder. 
3. The InDesign Location Plan from your second folder. 
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3. Open the "Move Pages..." Dialog 

In your SECOND InDesign File go into the Pages Panel by going to Window > Pages or pressing 
cmd+ F12 (ctrl+F12 on PC) 
Then, open up the drop-down menu (red box in the image) and select Move Pages... 

4. Move Pages from SECOND InDesign file to FIRST InDesign File 

1. Select which pages you want to move (all of them) 
2. Select where you want them placed in your FIRST InDesign document 
3. Select your FIRST InDesign document as where they will be Moved to. 
4. Click OK 
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5. Synchronize 

Perform a Synchronization (by pressing cmd+shift+2 on Mac or ctrl+shift+2 on PC) 

6. Complete! 

You can now see that the signs from your second SignAgent Pro™ files are now combined with 
your first SignAgent Pro™ file. (You can see exactly which ones by noting the Creation Information 
field) 

Complete! 
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SignAgent - FileMaker Go 
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Copy Database to iOS device 

Introduction 

Here are step by step instructions to copying a SignAgent Pro™ database to an iOS devise. 

DO NOT MODIFY BOTH THE IOS DATABASE AND COMPUTER DATABASE. 
ANY CHANGES MADE TO THE DATABASE ON THE COMPUTER WILL BE OVERWRITTEN WHEN 
COPYING DATABASE BACK OVER. 

Pre-Requisites 

1. iTunes 
2. iOS device (iPhone, iPod Touch, iPad) 
3. FileMaker Go on iOS device 

Step 1 - Close Files 

1. Close the database before you copy it to the iOS device 

Step 2 - iTunes 

Connect iOS device to computer via USB (not shown) 

1. Select: iPhone or the iOS device from the list that you want to copy the file to 
2. Select: Apps 
3. Scroll to the bottom of the Apps page 

Page 163SignAgent Pro 4.0



4. Select: FileMaker Go 
5. Press: Add… 

Step 3 - Choose File 

1. Select the database that you want to copy 
2. Press: Open 
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Complete! 

1. The database will now be present when you Open FileMaker Go on the iOS device 

Dis-connect iOS device to computer (not shown) 
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Copy Database from iOS device 

Introduction 

Here are step by step instructions to copying a SignAgent Pro™ database from an iOS devise back 
to your computer. 

DO NOT MODIFY BOTH THE IOS DATABASE AND COMPUTER DATABASE. 
ANY CHANGES MADE TO THE DATABASE ON THE COMPUTER WILL BE OVERWRITTEN WHEN 
COPYING DATABASE BACK OVER. 

Pre-Requisites 

1. iTunes 
2. iOS device (iPhone, iPod Touch, iPad) 
3. FileMaker Go on iOS device 

Step 1 - Close Files 

1. Close the database before you copy it from the iOS device 

Step 2 - iTunes 

Connect iOS device to computer via USB (not shown) 

1. Select: iPhone or the iOS device from the list that you want to copy the file from. 
2. Select: Apps 
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3. Scroll to the bottom of the Apps page 
4. Select: FileMaker Go 
5. Select: Database that you want to copy off of iOS device 
6. Press: Save to… 

Step 3 - Choose Location 

1. Choose the folder location you want to copy the database to 
2. Press: Open 

Page 168SignAgent Pro 4.0



Step 4 - Replace 

1. Press: Replace 

Complete! 

1. The database now contains all of the information that you have gathered. 

Dis-connect iOS device to computer (not shown) 
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Open Database on iOS Device 

Introduction 

Here are step by step instructions to Open a SignAgent Pro™ database on a iOS devise. 

Pre-Requisites 

1. iTunes 
2. iOS device (iPhone, iPod Touch, iPad) 
3. FileMaker Go on iOS device 

Step 1 - Open Browser 

Open FileMaker Go App (not shown) 

1. Press: Open File Browser… 

Step 2 - Select Option 

1. Press: Files on Device 
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Step 3 - Choose File 

1. Select Database you want to open 
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Complete! 

You now have access to the database on your iOS device 
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Delete Database from iOS device 

Introduction 

Here are step by step instructions to delete a SignAgent Pro™ database to an iOS devise. 

Pre-Requisites 

1. iTunes 
2. iOS device (iPhone, iPod Touch, iPad) 
3. FileMaker Go on iOS device 

Step 1 - iTunes 

Connect iOS device to computer via USB (not shown) 

1. Select: iPhone or the iOS device from the list that you want to copy the file to. 
2. Select: Apps 
3. Scroll to the bottom of the Apps page 
4. Select: FileMaker Go 
5. Select: Database that you want to delete off of iOS device 
6. Press: Delete key 
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Step 2 - Confirm Delete 

1. Press: Delete 

Complete! 

1. The database has now been removed from the list 

Dis-connect iOS device to computer (not shown) 

Page 176SignAgent Pro 4.0



Close Database on iOS Device 

Introduction 

Here are step by step instructions to close a SignAgent Pro™ database on a iOS devise. 

Pre-Requisites 

1. iTunes 
2. iOS device (iPhone, iPod Touch, iPad) 
3. FileMaker Go on iOS device 

Step 1 - Select Views Window 

1. Select views window 

Step 2 - Close Database 

1. Press: (X) 
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Complete 

You have now close the database on your iOS device 
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Tips & Tricks 
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Renumbering Signs in FileMaker 
Forgot a number in InDesign, and want an easy way to put it into sequence? This tutorial will teach 
you how to renumber your signs in FileMaker, giving you more automation and flexibility. 

The Problem... 

Sometimes in a large project, you may forget a sign, or the client may choose to add one where 
you weren't expecting. It can be a real pain to re-number all your signs in InDesign, even using the 
helpful renumbering tool. Here's an easy way to fix that problem. 
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1. Add your Sign in InDesign 

When you add your sign in InDesign, give it a number in between the 2 numbers that it sits 
between (for example, if it's between 112 and 113, make it 112.1) 

This will ensure that it sorts numerically in FileMaker 

Don't worry, it won't keep this ugly number when we're done. 

2. Sync 

Sync with FileMaker to move this sign information over to the database. 
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3. Find the Relevant Signs 

Next, in FileMaker, do a Find for the relevant signs. For example, if you'll need to re-number all the 
signs on Level 1, do a find for Level 1. 

If you only need to renumber all the E1 signs on Level 1, do a Find for both the Type of E1, and the 
Level of 1. 

4. Sort by Number in FileMaker 

Do a simple sort by number in FileMaker by clicking on the header saying "No."  twice. (Be sure to 
click on the words, and not on the little box with the arrow coming out of it) 

When done correctly, the Sort Order at the bottom-left corner of the SIGN table should display 
Number, Level 
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5. Mass Replace the Numbers 

1. Once you're happy with the Sort, click the Mass Replace Number button 

2. Input the number you'd like this found set to start with. 

3. Input the value you'd like this found set to increment by 

4. Click OK. 

6. Complete! 

Page 184SignAgent Pro 4.0



The numbers re-flow, giving us nice whole numbers again. And once we sync... 

You can see that the sign tags in InDesign now have the proper, cleaner numbers. 
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Merging Fields in FileMaker 
This tutorial will teach you how to merge 2 fields in FileMaker (or, in other words, add the contents 
of one field to another field) 

This is an advanced SignAgent Pro™ tutorial. 

1. Perform Synchronization 

Performing a synchronization before starting has 2 purposes. 

1. It ensures that all of your data is completely up to date. 
2. If anything goes wrong, you can simply use the files in the ARCHIVE folder again. You don't have 
to worry about losing any data. 

2. Identify the Fields to Merge 

We're going to be outlining this tutorial with an example... 
We've got a project with a large location plan, and we've been adding a general location to the 
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Notes field, based on the Architectural Grid. 
We would like to add these Notes to the Number field for more concise and efficient 
documentation. 

So, we would like for our Number fields to display C8-002, D4-004, B1-006, etc. 

3. Replace Field Contents 

1. Select the field that will be changing (in our example, the Number field) 
2. Go to Records > Replace Field Contents (or press Command + = on Mac, or Ctrl + = on PC) 
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4. Replace with Calculated Result 

Select Replace with calculated result: (or click Specify...) 
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5. Enter Calculation 

Now we enter the Specify Calculation dialog, a tool that is very powerful. You can replace the 
contents of this field across all records in your found set with a calculated result. 

For this example, we want to combine 2 fields and put a dash "-" in between them. 
To do this, we use the & tool. This combines the contents of 2 fields or calculations. 

As you can see above, we are using the formula Notes & "-" & Number to combine Notes, -, and 
Number 
We chose the field names from the list on the left. 
We are putting the - in quotation marks so that FileMaker doesn't confuse it with a minus-sign. 

When you're done, click OK, and then click Replace. 

Note: There are many other formulas that you can use in the list on the right. Feel free to check 
them out if you like! 
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6. Success! 

Success! The Notes field has been added to the Number field. 

You can use this technique to combine fields with other fields, calculations, text, and more! 

Another Example... 

Let's say your Room ID's are in the following format: 

Level Number 

Message 
[braille] 

example: 
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1 002 

Incinerator 
[braille] 

First, do a search for Room IDs (A1, in our example) 

Merge their fields like this 

Use the following phrase: Level & " " & Number & ¶ & ¶ & Message & ¶ & "[braille]" 

Note that we put a space in quotation marks between Level and Number 
A line break is represented by a ¶ 
[braille] is also in quotation marks (as it is just text) 
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Success! 

You can see that the message field is now in the proper format for Room IDs 

Note that I am viewing the SIGN table in the expanded layout to better show the multi-line 
messages 
(click SIGN again with Include Secret Preview turned OFF in the SETTINGS table) 
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Exporting and Importing 
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Importing from Excel 
This tutorial will teach you how to Import an Excel Message Schedule after a client review. 

NOTE: This tutorial assumes that you are importing an excel document that was first exported 
from the SIGN table in SignAgent Pro™ 3.0. See here for details: Exporting to Excel 

1. Start the Import from the SIGN Table 

1. Go to the SIGN Table (in FileMaker) 

2. Click the Import button in the toolbar 
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2. Choose Your File 

Find your file that you would like to import. (By default, it should've originally been saved into the 
Excel folder of your SignAgent Pro™ project folder, with the name SIGN.xlsx) 

3. Choose Fields to Import 

Now, you can choose the fields you would like to import back into the SIGN table. 
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A couple things to note... 

1. Keep the __pk__tl fields matched up (with the double-arrow). This is a unique identifier that 
helps SignAgent Pro™ match up the imported signs with the originals. 

2. By default, only the Client Notes field will import over... This means that any changes in the 
Excel file in the Client Notes column will carry over, and any changes in any other column will 
not. You can change this by clicking on the 2 dots for any other field (Type, Message, Notes, 
etc.) to change them to a single-arrow 

3. Don't import the first record... keep this box checked. 
4. Update matching records in found set... Keep this box checked (it will match signs based on 

__pk__tl) 
5. This means that if the client added any rows in the Excel file, they will be moved over to the 

SignAgent Pro™ file as new signs (but will only import the fields that you select... see step 2) 

Once you're happy with these settings, click Import 

Often, you probably won't have to change any of these settings... you can just click Import and it 
will import the Client Notes from the Excel Spreadsheet 

4. Import Options 

Keep this checkbox checked, and click Import 
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COMPLETE! 

The information from your Excel spreadsheet has now been imported back into the SIGN Table. 

Huzzah! 
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Exporting to Excel 
This lesson will teach you how to export records from your SIGN table to an Excel spreadsheet. 
Note that it will only export any records that are currently in the found set. 

1. Press Export Button in SIGN Table 

1. Go to the SIGN Table 
2. Click on the "Export" button 

2. Apply Excel Options (optional) 

Here you can apply options about the naming of the Excel Spreadsheet... take note that you can 
choose to include field names in the first row (or not) 
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3. Select fields to Export 

1. By default the information that gets passed back and forth to InDesign appears here plus 
Clients Notes and __pk__tl 

2. Use buttons to move other fields over to be exported 
3. Use to change the table 
4. These are the fields for the table shown in (3) 
5. Check this box if you want data formatting to carry over 
6. Press: Export 

NOTE: If you're planning on importing this spreadsheet back into SignAgent Pro™ at any time, do 
NOT delete the __pk__tl field... this is how SignAgent Pro™ identifies and matches up the signs. 
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COMPLETE 
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Exporting Sign Count to Excel 
This lesson will teach you how to export records from your SIGN table to an Excel spreadsheet. 
Note that it will only export any records that are currently in the found set. 

1. Go to SIGN Table, Sort by Type, then Export 

1. Go to the SIGN Table 
2. Click on the Type header twice. The sort order (at the bottom-left corner) should say "Sort Order: 
Type" 
3. Click on the "Export" button 
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2. Apply Excel Options (optional) 

Here you can apply options about the naming of the Excel Spreadsheet... take note that you can 
choose to include field names in the first row (or not) 

3. Select Fields to Export 
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1. We don't need the fields that are in here by default, so select "Clear All" 
2. Be sure to Group by TYPE::Order 
3. Add Type to the list (by double-clicking, or by selecting and choosing "Move") 
4. Add QUANTITY SUM to the list (by double-clicking, or by selecting and choosing "Move") 

Note that QUANTITY SUM will be your TOTAL sign count, and QUANTITY SUM by Order will be the 
count for each Sign Type. 

4. More Fields to Export 

1. In the drop-down list, choose TYPE 
2. Add Description to the list (by double-clicking, or by selecting and choosing "Move") 
3. Add Drawing to the list (by double-clicking, or by selecting and choosing "Move") 
4. Rearrange the list as you see fit, by using the arrows next to each line. The order here will be 

the order of the columns in your Excel spreadsheet. 
5. Click Export 
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COMPLETE 

Your sign count report is now in the Excel folder in your SignAgent Pro™ project folder. If you 
didn't choose to change the name in Step 2, then it will be called SIGN by default. 
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BONUS! - Sign Estimate Report in Excel 

To export a Sign Estimate Report (instead of a standard Sign Count report), follow all the steps 
above up to and including Step 4 (but DON'T Export yet) 

1. Add the Unit Cost field (when in the TYPE area) 
2. Go to Current Table ("SIGN") 
3. Add Extended Cost SUM 
4. Rearrange fields as you like, and click Export 

This will give you a Sign Estimate report in Excel... note that Extended Cost SUM will be your total 
cost over the project. Extended Cost SUM by Order will be the Cost per sign type across the 
project. 
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Exporting to another FileMaker database 
This tutorial will teach you how to export to another FileMaker database from SignAgent Pro™. 
This would be used if you needed to send signage information to a client or fabricator who uses 
FileMaker, but does not yet use SignAgent Pro™. 

Choose File Type 

Make sure that you find and sort the records in the order that you want them to be exported 

1. Select: File 
2. Select: Export Records… 
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Export Records to File 

1. Change file type to "FileMaker Pro" 
2. Enter in preferred name 
3. Choose Save location 
4. Press: Save 
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Specify Field Order for Export 

1. By default the information that gets passed back and forth to InDesign appears here 
2. Use buttons to move other fields over to be exported 
3. Use to change the table 
4. These are the fields for the table shown in (3) 
5. Check this box if you want data formatting to carry over 
6. Press: Export 
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Import Room Schedule 
Imagine this scenario: you've received a room schedule in Excel, but you really want to use the 
powerful sign programming and reporting tools in SignAgent Pro™. 
This tutorial will teach you how to use the "Import Room Schedule" Script in SignAgent Pro™ 3.0. 
This will allow you to import room schedules from Excel spreadsheets or other databases. 

1. Prepare Excel Spreadsheet 

Before we can import our existing message schedule, we have to prepare the spreadsheet we 
already have. 
This is done by ensuring that the first row contains logical titles or headings for each column. 

In this example, I've separated out the Sign Type, Floor, Location Number, Message, Phase, and 
Status 
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2. Import Room Schedule 

1. Go to the SIGN table 
2. Go to File > Import Room Schedule 
3. Select file to import from 
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3. Match Fields to Import 

Here you want to match up the fields from your Excel spreadsheet to your FileMaker database. 

A field is matched using the arrow from Source Field (Excel) to Target Field (FileMaker) 

You'll notice that I've matched up: 
Sign Type (in Excel) to Type (FileMaker) 
Floor (Excel) to Level (FileMaker) 
etc... 

Since there was no Excel column to match with Notes, Client Notes, or Internal Notes, etc. I have 
marked those with Don't import this field (two dots) 

You can switch from the arrow to the dots by clicking on the arrow (or the dots) 

You can rearrange the list on the right (to match fields) by clicking and dragging. 

Ensure that the following are also marked properly: 

Add new records 
Don't import first record (contains field names) 
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4. Identify First Sign 

A dialog box will now pop up identify the first sign that FileMaker wants to import. 
If you checked the Don't import first record box in the previous step, then this should be your first 
sign, and you can click Sign 

Complete! 

The room schedule from your Excel spreadsheet has now been imported into SignAgent Pro™! 
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Synchronization Note 

NOTE: If you add signs to FileMaker and then synchronize, InDesign will place these signs in 1" x 1" 
boxes at the top-left corner of your active page. You will need to adjust these and move them to 
their proper locations. See steps 4 & 5 of this tutorial here for more details on that: Creating a Sign 
in FileMaker 
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Using Scripts 
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Review Script Overview 

1. Open Scripts Panel 

In InDesign, open up the Scripts Panel. You can find this in Window/Utilities/Scripts. 

2. Activate Review Script 

Activate the Review Script by double-clicking on it in the Scripts Panel. 

3. Review Sign Content 

This will open up the Review Dialog and move your screen to the first sign in your project. 

In here, there are a number of important things to be aware of: 

1. Sign Selected - This displays which sign is currently selected, as well as its order on the current 
floor and in the entire project. 

2. Sign Content - This area displays the content of the currently selected sign. Note that you can 
not change the content directly from this dialog. 
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3. Review Notes - Here, you can enter any comments or notes about the sign before you approve 
or reject it. These notes will be added to the Notes field (after any existing notes) when the sign 
is approved or rejected. 

4. Approve - This button will change the Status of the sign to "Approved" and move you to the 
next sign. It will also apply a green stroke to your sign tag. 

5. Reject - This button will change the Status of the sign to "Rejected" and move you to the next 
sign. It will also apply a red stroke to your sign tag. Note that you'll need to add a reason in the 
Review Notes before you can mark a sign as rejected. 

6. Next Sign - This button will move you to the next sign in your project without assigning a new 
status or adding your review notes. 

7. Close - This will end the review process. 
8. Review Progress - These progress bars show your progress through the current level and 

through the entire project 
9. Show/Hide - These checkboxes allow you to choose whether or not to hide signs after they've 

been Approved or Rejected. 
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Scripts Overview 
This is an overview of the current version of the SignAgent Pro scripts. These scripts are fully 
compatible with all current versions of SignAgent Pro, so they should be the only scripts you use. 

Preferences.jsx 

This is the big one, prepare to save tons of time! Preferences will automatically apply certain 
preferences to your signs based on your choices. This includes: 
• Uniform width and height 
• Background/Text Colours based on the TYPE table 
• Layers based on either Type, Phase, or Review status 
• Character Style, unique per portion of the sign (similar to the old Style Script) 

For more details on this, check out the overview here: Using the Preferences Script 

You should probably set the preferences for your project before running the other scripts, as 
this will optimize the run-times, as well as make sure that you're always applying the most 
correct preferences to your project. 
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This is the big one, prepare to save tons of time! Preferences will automatically apply certain 
preferences to your signs based on your choices. This includes: 

• Uniform width and height 
• Background/Text Colours based on the TYPE table 
• Layers based on either Type, Phase, or Review status 
• Character Style, unique per portion of the sign (similar to the old Style Script) 

For more details on this, check out the overview here: Using the Preferences Script 

You should probably set the preferences for your project before running the other scripts, as this 
will optimize the run-times, as well as make sure that you're always applying the most correct 
preferences to your project. 

Edit.jsx 

The classic Edit dialog got some great improvements. The major changes are as follows: 
Quality of Life Enhancements 
• Screen now automatically moves to sign, if off-screen 
• Dialog will automatically move to side of screen, for improved visibility 
• Can scroll through selected signs, if you want to adjust them individually 
• Dialog now shows progress for times longer than 2 seconds 
• Edit will automatically apply Preferences (if Preferences have been set) 
• You can Edit grouped signs using the Selection Tool (or the Direct Selection Tool. Both will 

work) 
• To cancel, or abort the script, you can now hold the esc key 
• Bug fixes and efficiency improvements 
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The classic Edit dialog got some great improvements. The major changes are as follows: 

Quality of Life Enhancements 

• Screen now automatically moves to sign, if off-screen 
• Dialog will automatically move to side of screen, for improved visibility 
• Can scroll through selected signs, if you want to adjust them individually 
• Dialog now shows progress for times longer than 2 seconds 
• Edit will automatically apply Preferences (if Preferences have been set) 
• You can Edit grouped signs using the Selection Tool (or the Direct Selection Tool. Both will work) 
• To cancel, or abort the script, you can now hold the esc key 
• Bug fixes and efficiency improvements 

Sync.jsx 
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Faster and smarter than ever before! The sync script has had a major overhaul behind the scenes, 
resolving some bugs and improving performance. The major changes are as follows: 

Quality of Life Enhancements 

• Dialog no longer freezes in newer versions of Mac OS 
• Dialog now shows progress for times longer than 2 seconds 
• Sync will automatically apply Preferences (if Preferences have been set) 
• Automatically fixes or quarantines any damaged signs (if you modified the text manually) 

• This resolves the bug where signs would change locations randomly 

• Automatically matches version numbers for matching files, reducing the need for SyncFixes 
• To cancel, or abort the script, you can now hold the esc key 
• Bug fixes and efficiency improvements 
• Handles registration and authentication using your registration string 

Review.jsx 

Perfect for those who dread long boring sign review meetings, SignAgent Review™ is a script 
that will guide you, your supervisor, or your client through the review process much faster! It 
provides an update on progress as well as user and time stamped approvals/rejections. For 
details on this, check out the overview here: Review Script Overview 
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A "New Scripts" folder can be found in our shared SignAgent Pro™ Dropbox Folder, check it out! 

For instructions on how to set these up, check out: 

Install Scripts 

Keyboard Shortcuts 
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Preferences Script Overview 
The preferences script allows you to automate a number of project-wide customization options, 
including adjusting sign tag size, colours, object styles, character styles, and layers. This tutorial will 
walk you through the basics of this script. 

NOTE: The preferences script will apply these changes to all your signs in your InDesign 
document, so if you're unsure of what might happen, be sure to work from a copy or have a back-
up. 

To open up the Preferences dialog, open up the Scripts Panel (by going to Window/Utilities/Scripts) 
and then double-click on Preferences. If you don't see Preferences in here, you may have to install 
the script. For more info on that, check out Install Scripts 

1. Adjust Sign ID Tag Size 

These options are used to automatically resize your sign tags to a uniform width and height, across 
your entire project. This can be especially handy if you're importing a lot of signs from FileMaker! 
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2. Adjust Sign ID Tag Colour or Object Style 

Colour - This will automatically match the background colour and text colour of your sign tags with 
your TYPE table and your Reports. 

For more information on adding colours to the TYPE table, check out the TYPE Table Overview 

Object - This will allow you to apply a standard object style to all signs in your project. The 
dropdown list here is populated from your Object Styles panel. For more information on Object 
Styles, check out this article here: Using Object Styles 

3. Character Style 

This area replaces the existing Style script. For more info on how to use this feature, check out 
these tutorials: 

Use Character Style in Preferences Script 

Use Preferences Script to Hide Field in InDesign 

4. Layers 

These options will allow you to automatically place signs on different layers. Note that this will also 
automatically create the appropriate layers if they don't already exist. Note also that you won't be 
able to choose more than one option here. 

Layers - Choose to move signs to a Layer based on Type, Phase, or None 

Status - Choose to move signs to a Layer based on Status, or not 

Review - Choose to move signs to a Layer based on the results of the Review Script. For more info 
on that, check out this tutorial here: Review Script Overview 
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Preferences - Hide Field In InDesign 
In this tutorial I am going to show you how to hide the Level field in InDesign. We aren't removing 
it… we're just making it small and invisible! 

Before 

1. Notice the Level and Divider 2 are visible. 

1. Create New Character Style 
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NOTE if you have already created the "Hide" Character Style, you can skip to step 4. 

1. Open the Character Styles Panel by going to Window > Styles > Character Styles 
2. Select: Create New Style Button 
3. Double click on: Character Style 3 (or whatever the newest Character Style is called) 

2. Update Basic Character Formats 

1. Change Style Name to: Hide 
2. Select: Basic Character Formats 
3. Add Size: 0.1pt 
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3. Update Character Color 

1. Select: Character Color 
2. Set Fill: [none] 
3. Set Stroke: [none] 
4. Press: OK 
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4. Preferences Script 

1. Open the Scripts panel by going to Window > Utilities > Scripts 
2. Activate Preferences.jsx by double-clicking on it. 
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5. Set Character Styles 

1. Apply the style Hide to the fields you want to hide. In this case the Level and Divider 2 fields. 
2. Press: OK to apply 

After 
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Notice the Level and Divider 2 have disappeared to the eye. Feel free to resize the sign tags as 
you see fit. 
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Synchronization 

Introduction 

Here are step by step instructions on how to synchronize a SignAgent Pro™ 3.0 database (or 
higher) and location plans using the Sync_3.jsxbin Script 

The synchronization process always starts in InDesign and then FileMaker. 

Here is how the synchronization process works: 

1. Changes in the Database will be reflected on the Location Plan. 
2. Changes on the Location Plan will be reflected in the Database 
3. If you change the same sign in both, the Location Plan wins! 

Step 1 - Start Sync Script 

1. Use Keyboard Shortcut: Shift + Cmd +2 (Ctrl + Shift +2 on PC) 
Alternatively, you can double-click on the script in the Scripts Panel (see image) (Window > Utilities 
> Scripts) 

If you don't see the script in the Scripts Panel, it means that it's not installed... see here first: 
Install Scripts 
If you don't have the keyboard shortcut installed, see here: Keyboard Shortcuts 
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Step 2 - Perform Sync Script 

1. Press: Sync 

Every time you Synchronize, a copy of BOTH the InDesign file and the FileMaker database will be 
saved in the Archive folder BEFORE synchronization. 

Step 3 - Switch to FileMaker 

1. Switch to FileMaker when the dialog says: Switch to FileMaker, press Sync 
(NOTE: If you are using Mac OS X 10.11, El Capitan, the dialog may not tell you to Switch to 
FileMaker and Press Sync. Check out this article for details: Sync Script Makes InDesign Freeze) 
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Step 4 - Press Sync 

1. Select: SIGN Table 
2. Press: SYNC 

Step 5 - Database Updated 

1. Press OK 

Step 6 - Location Plans Updated 

1. Switch back to InDesign, and Press Done 
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Note that InDesign automatically saves after every successful synchronization. 

Complete! 

Your database and location plans are now fully synchronized! 
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Use Character Style in Preferences Script 
This tutorial explains how to use the Preferences Script to apply Character Styles. This will 
allow you to apply different styles to each of the fields globally across your project's Location Plans 
in InDesign. 

Note that this functionality replaces the old Style script. 

Before 

In this example I am going to apply a bold style and magenta colour to the Type field of all of the 
signs. 
Currently, there are no style applied to the characters in the signs. 
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1. Create Character Style 

NOTE: If you already have the Character Style that you want to apply, you can skip this step 

1. Open up the Character Style Panel by going to Window > Styles > Character Styles 
2. Click the New Style Button 
3. Edit the Style to your preferences. We are going to change the Character Colour to Magenta and 
the Basic Character Style to BOLD 

2. Select Script 
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1. Open the Scripts Panel by going to Window > Utilities > Scripts 
2. Select Preferences.jsx script 

3. Match Character Style to Field 

1. Click in drop-down beside field name and choose what style you want to apply. For this 
example, we're applying "New Style" to Type. Make sure the checkbox is marked as well. 

2. Press OK button to apply the selected styles. 
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After 

Voila! The New Style has a bold character style and magenta character colour, which has been 
applied to the sign type on all sign ID's across the project 

Additional Resources 

InDesign User Manual: Paragraph and character styles 
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SignAgent Pro™ 
Compatibility 

Page 238SignAgent Pro 4.0



Latest SignAgent Pro™ 

SignAgent Pro™ 3.0.1 

Compatible InDesign Scripts: 

• Sync_3.jsxbin 
• Edit_3.jsxbin 
• Style.jsxbin 

SignAgent Pro™ Log 

SignAgent Pro™ Log 
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Location of Version Number 
You must open the FileMaker Pro Database to find out what version you are using. 

1. The SignAgent Pro™ version number is located in the top right corner of every Table, often 
situated just above the Modification Information Field 

2. Another good way to know is by checking the title of your FileMaker Pro database... if it is 
SignAgentPro-3.fmp12 then you're likely using SignAgent Pro™ 3.0 
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SignAgent Pro™ Log 

SignAgent Pro™ 3.0.1 

(Only change is FileMaker Pro 14 compatibility) 

Compatible with: 

• Sync_3.jsxbin 
• Edit_3.jsxbin 
• Style.jsxbin 

SignAgent Pro™ 3.0 

Compatible with: 

• Sync_3.jsxbin 
• Edit_3.jsxbin 
• Style.jsxbin 

SignAgent Pro™ 2.5 

Compatible with: 

• Sync 2.5.0.jsxbin 
• Edit.jsxbin 
• Style.jsxbin 

SignAgent Pro™ 2.3 

Compatible with: 

• Sync 2.3.04.1.11.jsxbin 
• Edit.jsxbin 

SignAgent Pro™ 2.2.1 

Compatible with: 

• Sync-mac-v0.03d.jsxbin 
• Edit.jsxbin 
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Troubleshooting 
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JSInterface is undefined Error 

Got this error? Here's how to fix it! 

 NOTE that this error will only come if you are using the LEGACY version of SignAgent Pro. 
SignAgent is no longer providing updates to this version, as all development has been 
switched to the cloud version of SignAgent. 

To book a demo of the new version, schedule a time here: https://signagent.as.me/demo 

There are 2 possible reasons you could be receiving this error: 

1. The last version of the SignAgent scripts are only compatible with InDesign CC 2018. If you're 
using a newer version, you may get this error. 

2. If you're using the correct version, you may need to re-install the ExtendExtendScript Installer. 
You can find instructions on how to install the scripts, including this Installer, here: Install 
Scripts 

Page 243SignAgent Pro 4.0

https://signagent.as.me/demo
https://signagent.zendesk.com/hc/en-us/articles/213266163-Install-Scripts
https://signagent.zendesk.com/hc/en-us/articles/213266163-Install-Scripts


Registration Server Status 
Currently, our registration server for SignAgent Pro™ and SignAgent Manager™ is working as usual. 

This article will be updated whenever server status changes. 
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JSInterface is undefined Error 

NOTE that this error will only come if you are using the LEGACY version of 
SignAgent Pro. SignAgent is no longer providing updates to this version, as 
all development has been switched to the cloud version of SignAgent. 

To book a demo of the new version, schedule a time here: 
https://signagent.as.me/demo 

There are 2 possible reasons you could be receiving this error: 

1. The last version of the SignAgent scripts are only compatible with InDesign CC 2018. If you're 
using a newer version, you may get this error. 

2. If you're using the correct version, you may need to re-install the ExtendExtendScript Installer. 
You can find instructions on how to install the scripts, including this Installer, here: Install 
Scripts 
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Advanced Sync Fix 
The regular sync fix didn't work? Well, time to try this heavy-duty Sync Fix then. This is slightly more 
complicated, and involves muddling with some of the background information of SignAgent Pro™, 
so BE CAREFUL. 
When in doubt, WORK OFF OF A COPY. 

One thing to check before getting into these steps is the name of your project folder... Your project 
folder name should avoid using certain special characters, especially "&,*,%,#,!,+,=,and .," 

1. Find the fileVersion Number 

If you're stuck mid-sync, unfortunately the next step is to Force Quit and then reopen InDesign. 
Once you've done this, do the following: 

1. Open up the Structure by pressing cmd+opt+1 (ctrl+alt+1 on PC) or by going to View > Structure 
> Show Structure 
2. Open up FMPXMLRESULT by clicking the arrow 
3. Open up RESULTSET by clicking the arrow 
4. Open up the first ROW by clicking the arrow 
5. Open up the last COL by clicking the arrow. 
6. Take note of the number displayed here 
7. If there's no number here, open up this menu and select "Show Text Snippets" 
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Back to regular Sync Fix! 

Follow the steps here: Sync Fix 
Replace the fileVersion number with the number you found above. 

If this still doesn't work, then it's likely that something has gotten muddled in the background files 
of SignAgent Pro™, so our recommendation at this point would be to contact support and place 
your files into our shared DropBox folder. 
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Offline Registration Error (FileMaker) 
If you are seeing this message, it means that you are using an OUTDATED version 
of SignAgent Pro. You need to upgrade to SignAgent Pro 4.0 to resolve this issue. 

See this article for details: Upgrade to SignAgent Pro 4 

You will still be able to use the files and scripts normally, as long as this count is under 10. 

Once you hit the 10 of 10, you will no longer be able to use the files or scripts at all until you 
upgrade the files. 
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Object is Invalid Error 

Sometimes, this error will come up when trying to change sign types or Sync with the new scripts. 
This error is caused if you have your InDesign Object Styles sorted into Style Groups (or folders), in 
the Object Styles panel. 

We're aware of this bug and are actively working on a permanent fix. For now, here's a 
workaround to try. 

1. Open up the Object Styles Panel in InDesign. 

This can be done by going to View > Styles > Object Styles 

Page 249SignAgent Pro 4.0



2. Check for the Existence of Style Groups 

Note in the image below that some of the Object Styles at the bottom are sorted into a Style Group 
(using the folder icon) 

3. Move Object Styles out of Style Groups 

To resolve the error, just move the object styles that are in the Style Group (or folder), so that all 
styles are in one long list. This can be done by selecting all the object styles in that style group (or 
folder) and dragging them to the main list. You should end up with one long list, similar to the 
image below. 
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4. Sync or Edit as Normal 

With all the object styles out of their Style Groups, you should now be able to sync and edit 
normally. You can choose to delete or keep your style groups. 
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We know that this is a bit of an annoying workaround, as you may have your object styles 
organized nicely for your different projects, but this should help you to continue working with 
limited disruption until we're able to release a fix for this bug. 

Still having problems? Send your questions to support@signagent.com 
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Why does my InDesign look like this? 
This article will outline some of the reasons why your InDesign looks weird, and how to fix them. 

Weird brackets and Purple Dots? 

Sometimes you'll open InDesign or hit something by accident and all of your sign tags will look 
something like this, with orange and green brackets and purple dots within the rectangle. 

This is because you are in Normal Screen Mode. This mode includes visual representations of 
paragraph breaks, overset text, and the DATA and XML tags in SignAgent Pro's sign tags. 
You should be in Preview Screen Mode. This gives a cleaner and more elegant view of the project 
and your sign tags. 

You can switch between the two modes by pressing W or by going to View > Screen Mode 
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What's wrong with my floor plans? 

Your floor plans are all blurry and illegible... not much use! There's 2 reasons why this could be... 
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1. Typical Display Performance 

Your Display Performance is on "Typical Display" when it should be on "High Quality Display" 
Don't worry, this shouldn't cause any performance issues, as long as your plans have reasonable 
file sizes. 

To fix this, simply right-click (or ctrl+click) on your floor plan, and select Display Performance > High 
Quality Display 

2. Missing/Modified Links 

If you try step 1. and that doesn't do anything, you may have a missing link. 

First, open up the Links Panel (Window > Links) 
If there's a Red circle with a question mark in it, then you're missing the link. This means that the 
original file has been moved, modified, or deleted and InDesign can't find it. 
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You can fix this by double-clicking on the red circle with a question mark and finding the file 
manually. 
You can avoid this by keeping your floor plans in your SignAgent Pro™ folder (We suggest inside 
the Links folder!) or somewhere else static. 

See the Adobe online tutorials for more info here: When to Link Graphics 
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InDesign Authorization Error 
This tutorial will teach you how to resolve the InDesign Authorization Error, as well as how to avoid 
it in the future. 

Script Alert 

SignAgent Pro™ sends an authorization code from FileMaker to InDesign whenever you try to 
activate a script; this error means that InDesign is not receiving that authorization. 
There a few possible reasons for this: 

1. SignAgentPro-3.fmp12 is not open 

SignAgent Pro™ requires for both files to be open in order to use the scripts, including Edit and 
Sync. 
To resolve this, open the SignAgentPro-3.fmp12 file that is related to your InDesign file (ie. in the 
same folder) and try again 

2. SignAgentPro-3.fmp12 has been open for a really long time. 

If you have had your SignAgentPro-3.fmp12 file open for a significant period of time, the 
authorization code will expire and InDesign will no longer be able to use scripts. 
This length of time varies from machine to machine, but it's usually 24 hours. 
To resolve this, close down the SignAgentPro-3.fmp12 file, reopen the SignAgentPro-3.fmp12 
file and try again 
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3. Permissions Issues 

If you don't have full administrative privileges on your computer, you may need to get IT to allow 
Full Read & Write Permissions for the SignAgent Pro™ folder and all enclosed files and folders. 
After this is done, close down both the InDesign file and the FileMaker file, re-open them, and try 
again. 
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FileMaker Network Sharing Message 

Why does this message pop up every time I open SignAgent Pro? 

The SignAgent Pro file is set to share the database over the network. However, your FileMaker 
application is not set to share over the network. 

You need to turn on Network Sharing. 

Step 1 - Open FileMaker Pro 

Open FileMaker Pro directly without opening the SignAgent Pro™ file… or Close SignAgent Pro file 

Step 2 - Select FileMaker Network 

1. Select: File 

2. Select: Sharing 

3. Select: FileMaker Network… 
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Step 3 - Set FileMaker Network Settings 

1. Select: Network Sharing: On 

2. Press: OK Button 
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Finished! 

Next time you open SignAgent Pro™ the dialog will be gone! 
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Sync Script Makes InDesign Freeze 
NOTE: This bug has been completely resolved with the new Sync.jsx script. Updating to the new 
version should fix this problem! 

Some users have been experiencing an issue (specifically after updating to OS X10.11 El Capitan or 
later), where starting the Sync_3.jsxbin script will cause InDesign to freeze... this tutorial will tell 
you how to fix that! 

1. Start Sync From InDesign 

First things first... start your Sync from InDesign by using the keyboard shortcut command+shift+2 
(Mac) 

If you're experiencing this error, it will appear like nothing is happening, and InDesign will become 
non-responsive... 
HOWEVER, what is actually happening is that the Sync Script is running normally (but without the 
progress bar in InDesign) 

When InDesign is ready, you can switch to FileMaker and press Sync, as usual. But how do you 
know when InDesign is ready? 
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2. Check the XML folder 

When InDesign is ready, it will export a file entitled from_ID.xml to the XML folder of your 
SignAgent Pro™ folder. 

So, to verify that this has happened, just check the modification date on that file. 

3. Switch to FileMaker and Press SYNC 

Once you've verified that from_ID.xml has been modified, you can now complete the 
synchronization by switching to FileMaker Pro and pressing SYNC. 
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Sort Missing Error 
This tutorial will teach you how to fix the Sort Missing Error message if it pops up when choosing a 
report. 

If you get this error, it means that the Sort Order in the REPORTS table does not match up 
perfectly with the Sort Order specified in the file__sortSize___report Script, and you will be unable 
to see the report in that particular sort. Here's how to fix that! 

1. Copy the Necessary Sort Order Text 

1. Go to the REPORTS Table 
2. Find the Sort Order in question and copy the text from that field (it must be copied EXACTLY for 
this to work properly) 
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2. Manage Scripts 

1. Click Reports in the SIGN Table 
2. Click Edit (on any layout, it doesn't matter which) 
3. Go to Scripts > Manage Scripts... 
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3. Open up the file__sortSize___report 

1. Double click on file__sortSize___report (or select it and choose Edit) 
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4. Adjust the Script Line in Question 

1. Find the Sort Order in question (in this case, "Type /Level/Number"... NOTE the space in the 
existing line... even a small typo like this will give you the above error) 
Double-click on it. 
2. In the dialog box, correct the text in the quotation marks (You can paste the text that you took 
from Step 1 here) 
3. Click OK and exit out of the Script dialog boxes (Make sure to SAVE your changes!) 

NOTE: If there is no corresponding line for the desired Sort Order, you will have to create one... 
see this tutorial for details: How to Add a New Sorting Order 
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Complete! 

If the Sort Order record in the REPORTS table matches up with what you just entered in the 
file__sortSize___report Script, everything should now be resolved! 
Happy reporting! 
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Sync Fix 
What to do when the you have started in InDesign and you get the "Start synchronization in 
InDesign" Error. 

1. Don't Panic! 

You do not need to panic and you do not need to force quit InDesign. 

2. Update fileVersion Number 

You will need to update the fileVersion number by performing the following tasks calmly… 

2.1 Switch to InDesign_Import Layout 

Page 269SignAgent Pro 4.0



1. Click: SIGN 
2. Choose: InDesign_Import 

2.2 Update fileVersion Number 

1. Update the first record's fileVersion number to (-1) of the current contents. So if it was 201 it 
should be 200. 

Note that if you don't see any numbers here, or if you're not viewing all the records, be sure to 
click the "Show All" button near the top of your screen and then go to the first record. 

3. Retry Sync 

3.1 Switch to SIGN Layout 

1. Click: InDesign_Import 
2. Choose: SIGN 
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3.2 Synchronize 

1. Press: SYNC 

4. Done! 

Thank you for not panicking! 

Did this not work? Please continue to not panic, and try this: Advanced Sync Fix 
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Pre-Sales Information 
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Adobe InDesign Compatibility 
All versions of Adobe InDesign CC up to 2018 are compatible with SignAgent Pro. If you do not own 
a compatible version of InDesign you will need to purchase Adobe InDesign CC. 

UPDATE: Note that newer versions of InDesign (2019 and 2020) are not compatible with SignAgent 
Pro scripts. 

Compatible versions of Adobe InDesign 

* Adobe InDesign CC (up to 2018) 

InDesign 2018 is available for an easy and free downgrade for anyone who has an active Creative 
Cloud subscription. You can see details on that here: Install Previous Version of CC Application 

Incompatible versions of Adobe InDesign 

Adobe InDesign CS6 & Earlier 

All other version of Adobe InDesign are incompatible with SignAgent Pro™. You may be able to 
open the file. However, there is no guarantee that the scripts will function correctly. 

You can learn more about InDesign here: http://www.adobe.com/products/indesign.html 
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FileMaker Pro Compatibility 
FileMaker Pro Advanced 17 is the latest version of FileMaker Pro that is compatible with SignAgent 
Pro. If you do not own a compatible version of FileMaker you will need to purchase FileMaker Pro 
Advanced 17. 

Incompatible versions of FileMaker Pro 

* FileMaker Pro 11 & Earlier 

All other versions of FileMaker Pro are incompatible with SignAgent Pro. The database will not 
function properly, and may not even open. 

Note that we are no longer actively developing SignAgent Pro, so future versions of FileMaker Pro 
Advanced may or may not function properly. 

You can learn more about FileMaker Pro Advanced here: FileMaker Pro Advanced 
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Software Requirements 
The following software is required for SignAgent Pro. 

• FileMaker Pro 12+ (up to 17) 
• Adobe InDesign CC (up to 2018) 

FileMaker Pro (Advanced) 

FileMaker Pro is the first software requirement for using SignAgent Pro. The most recent version 
that is compatible is FileMaker Pro Advanced 17. 
Development is no longer ongoing, and future versions or updates to FileMaker Pro may or may 
not be compatible. 

You can learn more here: FileMaker Pro 

If you need a trial version to get started, you can find that here: FileMaker Pro 17 Trial 
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Adobe InDesign 

Adobe InDesign is the second software requirement to use SignAgent Pro™. 

Versions of Adobe InDesign CC will work, up to and including CC 2018. For more info on which 
versions are compatible, check out this article here: Adobe InDesign Compatibility 

You can learn more here: Adobe InDesign 

If you need a trial version to get started, you can find that here: InDesign Trial 

Note that InDesign 2019 is not currently compatible, as we're waiting on an update that will allow 
InDesign 2019 to connect to our authentication server. 

InDesign 2018 is available for an easy and free downgrade for anyone who has an active Creative 
Cloud subscription. You can see details on that here: Install Previous Version of CC Application 
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Suggested Reading 
This documentation is not intended to be a FileMaker or InDesign guide. It will provide details 
about SignAgent Pro™ specific tasks. You will need to refer to the appropriate FileMaker or 
InDesign documentation for application specific issues. 

FileMaker Pro 

FileMaker Pro 14 User Guide 
https://fmhelp.filemaker.com/docs/14/en/fmp14_users_guide.pdf 

FileMaker Pro Support Page 
http://help.filemaker.com 

Lynda.com 
http://www.lynda.com/FileMaker-training-tutorials/116-0.html 

InDesign 

Adobe InDesign User Guide 
https://helpx.adobe.com/pdf/indesign_reference.pdf 

Adobe InDesign Support Page 
http://helpx.adobe.com/indesign/topics.html 

Lynda.com 
www.lynda.com/Adobe-InDesign 
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Important 
Announcement - 

SignAgent™ 
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New Product! SignAgent™ 
Important news for anyone using SignAgent Pro™ or SignAgent Manager™... 

SignAgent Inc. has released it's newest product called SignAgent™. It's a cloud-based web 
application that takes all the best parts of SignAgent Pro™ and SignAgent Manager™ and adds 
flexibility and collaboration. 

Some of the highlights: 

• No more FileMaker and InDesign! 
• No more syncing! 
• Complete flexibility; do your work your way. 

• Add or remove whatever fields you want, including message fields, repeating fields, and 
other fields. 

• Customize your own projects with specialized workflows that signs can go through as the 
project progresses 

• Easy sign creation and editing. 
• Collaboration! 

• Invite your team members to be part of your organization, or just invite them to the projects 
they need to be part of. 

• Invite your clients or supervisors to view the project and make comments with NO 
ADDITIONAL COST! 

• Easy artwork creation with Illustrator Templates 
• Plus all the other great features of SignAgent Pro™ and SignAgent Manager™ 

 If you're interested, check out our website and give it a try... it's free for the first 30 days! Check 
that out here: Try SignAgent™ 

Page 279SignAgent Pro 4.0

https://app.signagent.com/accounts/signup/


SignAgent Pro™ Update 
Logs (Old) 
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Synchronization Dialog 
This article will outline the changes and new features in the SignAgent Pro™ 3.0 Synchronization 
Script 

Install New Scripts and Keyboard Shortcuts 

To install the new scripts (Edit_3.jsxbin and Sync_3.jsxbin) just follow this tutorial: Edit Script 
You can also remove the old Edit script (Edit.jsxbin) 
If you still have old SignAgent Pro™ projects, you should keep the appropriate Sync script 
installed... if not, feel free to delete that too. 
To reassign keyboard shortcuts, just follow this tutorial: Keyboard Shortcuts 

For your information... The new Sync_3.jsxbin script will ONLY work with SignAgent Pro™ 3.0 
databases... and likewise SignAgent Pro™ 3.0 databases will ONLY work with the Sync_3.jsxbin 
script. 
If you have any older SignAgent Pro™ databases... you should keep the appropriate Sync scripts for 
those versions of SignAgent Pro™ 

1. Improved Archiving in Synchronization 

So you may have noticed that, in the Archive folder, there are now TWO different files that show 
up when you synchronize... 
1. A FileMaker database (SignAgentPro-3.fmp12) 
2. An InDesign document (SignAgentPro-3.indd) 

So, what happens is that every time you start a synchronization (from InDesign), it will save a copy 
of the InDesign document and the FileMaker database, AS THEY WERE before synchronization. This 
means that there will always be a matching set of files in the Archive folder, in case you have a 
crash, or in case you've made an error. 
These files will be overwritten every time you start a sync from InDesign. 
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If you need to revert to these files, all you need to do is move (or copy) them back into the main 
SignAgent Pro™ folder, replacing the newer ones with the archived ones. 

InDesign will also save after a completed synchronization into the main folder... which means you 
don't have to worry about forgetting to save after Synchronization and getting that nasty "Start 
synchronization from InDesign" error anymore. 

2. Server-based Synchronization 

The second exciting thing is that you can now SYNCHRONIZE ON A SERVER! Gone are the days 
where you would have to copy your files to the desktop, synchronize, and then copy your files back 
to the server. You can now keep your files saved wherever you like, and it will synchronize 
successfully. 

3. Miscellaneous Bug Fixes 

1. Changes from lower-case to upper-case and vice versa are now always recognized and applied 
when synchronizing. 
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Translation Table 
This article outlines the changes in the Translation Table in SignAgent Pro™ 3.0 

Primary Message Updater 

The newest feature in the TRANSLATION Table is that you can update Primary Phrases and have 
them applied globally throughout the messages in the SIGN table. 

Let's do an example... 

1. Pick your primary message 

Let's say you have to change all the messages in your project from "Bathroom" to "Restroom" 
The Translation table identifies unique messages in the Message field, separated by returns. 

So, for example, WOMEN'S BATHROOM would be a unique message (no return to separate), but 
BATHROOM and MALE would be separate unique messages because they are separated by a 
return (inputted by the user) 
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2. Update Message in Translation Table 

Go to the TRANSLATION Table (by clicking TRANSLATION) and click UPDATE to ensure that 
everything in there is up-to-date... 
Next, find the primary message you want to change (BATHROOM) and change it to what you want 
(RESTROOM) 
A dialog box will now pop up asking if you would like to update all BATHROOM Messages to 
RESTROOM messages in the SIGN table... Click YES. 
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3. Complete! 

Your messages have now been updated... the TRANSLATION table finds all instances of 
"BATHROOM" and changes it to "RESTROOM" 
You'll notice that "WOMEN'S BATHROOM" was not updated, as it is a unique message of its own. 
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Edit Dialog 
This article will outline the changes in the new Edit Script and Dialog. 

Install New Scripts and Keyboard Shortcuts 

To install the new scripts (Edit_3.jsxbin and Sync_3.jsxbin) just follow this tutorial: Install Scripts 
You can also remove the old Edit script (Edit.jsxbin) 
If you still have old SignAgent Pro™ projects, you should keep the appropriate Sync script 
installed... if not, feel free to delete that too. 
To reassign keyboard shortcuts, just follow this tutorial: Keyboard Shortcuts 

Fun fact... the new Edit script will also work with old SignAgent Pro™ projects! So even if you have 
projects that aren't upgraded to SignAgent Pro™ 3.0, you can still take advantage of this new script! 

New Feature: Reflow Numbers in InDesign 

Here's an example of how the new Number Reflowing works... 
Let's say that you've created some new signs in InDesign (as pictured above), but you need them 
renumbered properly (as indicated). 
What you would do is select all the signs to be renumbered, in the order indicated above. (You can 
do this by selecting one by clicking on it, and then holding shift and clicking on the other signs in 
order) 

Next, Press cmd+shift+1 on Mac or ctrl+shift+1 on PC to bring up the Edit Dialog 

Page 286SignAgent Pro 4.0

https://signagent.zendesk.com/entries/80943785-Install-Scripts
https://signagent.zendesk.com/entries/80657019-Keyboard-Shortcuts


You'll notice a new field in the Edit dialog: Increment. This will only show up if you have multiple 
signs selected. 
In order to reflow these numbers, enter your initial number in the number field, and the 
incremental value in the increment field. 
If you want to reflow, you'll also want to confirm that both the Number field checkbox AND the 
Increment field checkbox are checked. 
For our example, the initial value is 001, and we want each sign number to increase by 1. 
Then we'll click OK. 
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You can see that the numbers have correctly reflowed themselves in the order we selected. 
This new feature makes it a lot easier to reflow numbers while confirming visually that they're in 
the correct space. 

Miscellaneous Bug Fixes 

1. In the new Edit Script, Background colours no longer show up in the Type Field Dropdown list. 
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What's New in SignAgent Pro™ 3.0 

Greetings SignAgents! 

If you're reading this, it means that SignAgent Pro™ 3.0 has just been released, and you're curious 
about the new features and changes. Here's a comprehensive list of things to look out for. (It's 
long, but please read through this!) 

1. Folder Structure 

Firstly, there's a new folder structure! 

Things that are new: 
1. New Reports folder... this folder is what contains the files necessary for you to create 
customizable reports! (More on that in a minute) 
2. More in the Archive folder 
3. You can NOT change the name of the FileMaker database anymore. Any attempts to do so will 
cause an error. 

For more details, check out this article: Folder Structure 
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2. Edit Script 

Next up we've got a new and improved Edit Dialog Script! 

To use it, install the script Edit_3.jsxbin 

Things that are new: 
1. New re-numbering capability! Just select multiple signs in the order you want to reflow them, 
select an increment and change your sign numbers with ease! 
2. Colour Values will no longer show up in the Type dropdown menu 

For more details, check out this article: Edit Dialog 
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3. New Synchronization Script! 

Thirdly, it's the new Synchronization Script! 

To use it, install the script Sync_3.jsxbin 

Things that are new: 
1. The synchronization now saves an Archive of the .indd file AND the .fmp12 file before the 
synchronization and it saves it AGAIN after synchronization... this should mean the end of those 
pesky "Start synchronization from InDesign" errors! (or at least make them a lot more rare!) This 
also gives you extra security in case of a crash or other unexpected error. It's good news all 
around! 
2. This version also works FROM THE SERVER! This is something you've been asking for for a while, 
and now it works! You can now synchronize your files properly, even when they're hosted 
remotely. 
3. This version also fixes the issue where sometimes letter case changes weren't recognized (going 
from upper case to lower case or vice versa). They are now! 

For more details, check out this article: Synchronization Dialog 
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4. Improved Translation Functionality 

The new and improved translation table is definitely worth checking out, even if you don't usually 
use message translation in your projects! 

Things that are new: 
1. Now, if you change the primary message (so, the NON-translated message), it will give you the 
option to automatically change all instances of that message in the SIGN table as well! So if you 
need to change washroom to restroom, or you realized that you've been spelling Receiving wrong 
all along, here's an easy way to change it across the board. 

For more details, check out this article: Translation Table 

5. CUSTOMIZABLE REPORTS! 

This is the big one! You can now create your own reports completely to your own specifications! 
Change everything from fields displayed to sorting options to font to colours to logos, you can 
make as many different reports as you want for different projects and different needs. 
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It's worth noting that the original reports that you know and love are still included in this release as 
well. 

Things that are new: 
1. Pretty much everything. There's a lot to see here; for more details, check out these tutorials 
here: REPORTS 

6. Miscellaneous Others 

Here's some other smaller additions and changes in SignAgent Pro™ 3.0 

1. Support Tab now links directly to Web site... no more confusing log-in window embedded into 
SignAgent Pro™ 
2. After creating a new type by entering it into the Type field in the SIGN table, it is now 
automatically placed into alphabetical order in the TYPE table... you can then sort it as you please. 
Same goes for LEVEL, PHASE, and STATUS 
3. Default reports now have consistent font across the board... the always classic Helvetica Neue 
4. The footer on default reports is now back to a true 7"x 1" 
5. In SignAgent GO™, the second defect image is now modifiable 
6. Sometimes, notes in the TYPE table would superimpose onto the Translate and Hide 
checkboxes. This is now nothing but a distant memory. 
7. The errors in printing reports when Saving as PDF are resolved. 
8. The Headers in the TYPE table (Notes 1, Notes 2, Notes 3) are no longer customizable in order to 
facilitate report customizing. 
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